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Introduction 

What is WYNN? 

WYNN® (What You Need Now) is a software program for people 
who struggle with reading and writing. The features in WYNN 
allow you to: 

¶ Acquire documents, such as textbook passages, memos, or 
magazine articles, into WYNN and save them 

¶ Open a document or Web page and have WYNN read it 
aloud to you 

¶ Easily change the way the text looks to make it easier to 
read 

¶ Use writing tools to make writing assignments easier 

¶ Use study tools to help you learn  

WYNN uses a series of color-coded toolbars to help you quickly 
access reading and writing assignments. You can do almost 
everything using the buttons on the toolbars that appear across 
the top of the screen. For more information, see Getting to Know 
WYNN (page 65).  
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WYNN Wizard and WYNN Reader 

Two versions of WYNN software are available: WYNN Wizard and 
WYNN Reader. 

WYNN Wizard is a full-featured application that includes: 

¶ Optical character recognition (OCR), which allows you to 
acquire and read pages, as well as read existing word 
processing and text files  

¶ Document composition and editing tools like word prediction, 
spell checking, and homophone recognition 

¶ The ability to browse the World Wide Web to assist with 
topic research  

¶ Traditional study aids like highlighting, bookmarking, 
outlining, and dictionary and thesaurus usage 

¶ Visual and auditory adjustments to make it easier to read 
and comprehend documents  

¶ Single-user or network licensing available 

WYNN Reader includes the same features and functionality that 
are in WYNN Wizard, except for scanning and OCR capabilities. 
Use WYNN Reader to read electronic documents, create or edit 
documents, and browse the Internet for document research. 

Single-User and Network Versions 

Both WYNN Wizard and WYNN Reader are available as single-
user or network licensed products. The single-user version easily 
installs onto a single computer, while the network version allows 
as many clients as possible, based on the number of licenses 
purchased, to use the software at once over a local area network 
(LAN).    
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What's New in WYNN 

WYNN has many exciting new features for our users.  

PEARL Camera Support 

Lightning-fast OCR with the portable PEARL® camera. PEARL is a 
portable camera that can be connected to your USB port and used 
any time you need to capture pages on the go. PEARL weighs just 
two pounds, and it provides fast and accurate page recognition. 
Once you connect the PEARL camera, go to the Advanced menu 
and change your Device Selection from your flatbed scanner to 
PEARL, then acquire as usual. See PEARL Camera Commands 
(page 205) for more information.  

Book Search 

Search for Bookshare.org, Gutenberg, and Baen books from 
within WYNN. You can search by title or author. If searching for 
books in Bookshare, you can use either your individual or 
organizational membership to download available books. Book 
Search is available from the Launch menu, or by using the 

keyboard shortcut CTRL+K.  

MathML 

Support for math and science formulas written using MathML, the 
math mark-up language adopted as part of the NIMAS standard. 
Just open any MathML document in WYNNôs Web browser, and 
you can read the formulas written in MathML by right-clicking 
them.  
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Skim Reading  

Save time while studying by quickly checking out whatôs in a 
document before reading it thoroughly. Skim reading will read just 
the first sentence of each paragraph, so you can get a quick idea 

of whatôs in the document. Skim Reading is available in the Tools 

menu, or by using the keyboard shortcut SHIFT+F2 (see page 46). 

Split View 

See Exact View and Text View simultaneously. This provides easy 
comparison of the original document and the resulting Text View, 
which allows visual tailoring to assist with visual processing 
difficulties. Just toggle the View button on the toolbar until you get 
to the Split View. When finished with Split View, toggle the View 
button back to either Text or Exact View.  

Two-tone Exact View 

Use the same custom colors for Exact View as you do in Text 
View.  If you prefer using a light blue background, this new feature 
will set your Exact View background to light blue, too. Two-tone 
Exact View is found on the View menu, or by using the keyboard 

shortcut CTRL+2 (see page 49). 

Crisp Exact View 

Technical advances have made WYNNôs Exact View even more 
crisp and clean, providing an even better user experience.  

Whatôs in this Box? 

The following items are in your WYNN package. If you discover 
damaged or missing items, please contact your retailer. 

¶ Disk wallet containing a WYNN program DVD and an 
Authorization CD. You may receive authorization labels and 
a cover letter depending on how you purchased WYNN. 
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¶ Microphone 

¶ WYNN Userôs Guide 

¶ WYNN Quick Start Guide 

¶ Authorization number labels and cover letter (Non-network 
Multi-user version only). If you receive multiple boxes, your 
authorization labels will be in one box marked with a label. 

Online Help 

There are several ways to get help when using WYNN: the help 
topics, status bar help (page 6), context-sensitive help (page 7), 
and the Readme file (page 8). 

Help Topics 

To open online help, do one of the following: 

¶ Press the F1 key, or  

¶ Click the Help menu, and then click the WYNN Help 
command. 

 

The following illustration shows the various components of the 
Help window that appears. 
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Use the Table of Contents (left window pane), the Index or 

Search tabs, and the topic links (right window pane) to select and 

view an area of interest. When you are done, click the Close 

button ï  ï on the title bar to close the online Help. 

Status Bar Help 

When you move the mouse pointer over a menu command, the 
status bar at the bottom of the WYNN window displays a short 
description of the command.  See next figure. 
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Context-Sensitive Help 

WYNNôs context-sensitive help shows information about a specific 
option or button in a dialog box. There are three types of context-

sensitive help: the Question Mark button, the F1 key, and the 

Whatôs This? button. 

To use the Question Mark button, do the following:  

1. Click the Question Mark button ï   ï in the upper right 
corner of the dialog box, which changes the appearance 
of the mouse pointer.  

2. Click any option in the dialog box. WYNN displays a 
context-sensitive help message for that item.   

 

To use the F1 key,  



Introduction 

 

8   

¶ Select an item within a dialog box, and press the F1 key. 
WYNN displays a context-sensitive help message for that 
item.  

To use the Whatôs This? button, do the following:  

1. Use your mouse to right click within the dialog box. The 

pointer becomes a floating Whatôs This? button. For 
example: 

 

2. Click the button on an item to open the context-sensitive 
help message for that item. 

The Readme File 

WYNNôs Readme file gives you the latest software release 
information. It is available during product installation and, later, in 
the WYNN program group.  

To open and read the Readme file: 

1. From the Windows Start menu, click All Programs or 

Programs, and then point to the WYNN program folder. 

2. Click the WYNN Readme shortcut to open the Readme 
file.  

Contacting Freedom Scientific 

Use the following options to contact Freedom Scientificôs support 
staff.  

¶ World Wide Web site: http://www.FreedomScientific.com/lsg 

¶ Technical Support e-mail: Support@FreedomScientific.com 

¶ Technical Support Telephone: (727) 803-8600  
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When contacting Freedom Scientific, be prepared to provide the 
following information: 

¶ Product name, version number, and serial number  

(This information appears in the About dialog box, which is 

available from the Help menu.) 

¶ Type of computer hardware you are using 

¶ Version of Windows running on your machine 

¶ Exact wording of any messages on your screen 

¶ What you were doing when the problem occurred 

¶ Steps you have taken to solve the problem 

Technical support is available Monday through Friday from 8:30 
AM to 7:00 PM, Eastern Time (ET). 
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WYNN Single-User and Non-Network 
Multi-User Installation 

Important:  
The procedures in this chapter assume that you can 
access the Internet from your computer for software 
activation. If you do not have Internet access, refer to 
Activation Options on page 215 for other activation 
procedures.  

Note:  The single-user version uses the Authorization CD, while 
the Non-Network Multi-User (NNMU) version uses 
Authorization numbers printed on supplied labels. 

Note:  If you are installing the network version of WYNN, refer to 
Network WYNN Installation on page 16.  

Before You Begin 

¶ Verify the minimum system requirements (see page 199) 

¶ Verify that you have an Internet connection (required to 
activate your software quickly using the Internet) 

¶ Determine if you are installing the Non-Network Multi-User or 
single-user WYNN version versus the WYNN network 
version.  

¶ Uninstall any previous version of WYNN 
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WYNN Installation Process 

Read Me First:  
If you have WYNN 5.10 or earlier installed on your 
computer, uninstall the software before installing WYNN 
6.0 or later. Note that any documents created using earlier 

WYNN versions will not be removed and will remain in 
your user documents folder. To uninstall WYNN, see page 
15. 

Important:   
If you will be using the PEARL camera with WYNN, do not 
connect the camera to your computer until the WYNN 
installation is complete. For more information on 
connecting and setting up PEARL, refer to the PEARL 
Quick Start Guide. 

To install WYNN on your computer, do the following: 

1. Insert the WYNN disk into your DVD drive. 

2. The WYNN Setup program starts, and displays 
installation instructions. Follow these instructions to 
complete the WYNN installation.  

Note:  If the program does not start automatically, run Setup.exe 
on the program disk.  

3. When prompted,  

¶ Type your serial number if installing the Non-Network 
Multi-User version 

¶ Choose Stand-alone WYNN or Network WYNN 
installation 

¶ Choose WYNN Wizard or WYNN Reader installation 

¶ Choose your language locale, for example, U.S. 
English or another language 
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¶ Choose if you want to install public domain books.  
Over 200 books by famous authors are available for 
your enjoyment. The majority of these books appear in 
required reading lists for high school and college 
students, as well as being listed among various 
posting of the top 100 books of all time. Other books in 
this collection are included because they are the 
writings of famous authors, or they are the books that 
continue the story of another famous book. 

4. Next, the setup program installs the RealSpeak Solo 
Direct speech synthesizer. It contains different voices for 
you to use as WYNN speech. You must accept the End 
User License Agreement (EULA) to continue installation. 
(This synthesizer is not available for the 40-minute demo 
version downloaded from the Web.) 

Note:  After fully installing WYNN, you can sample and download 
other RealSpeak Solo Direct voices by visiting 
www.freedomscientific.com, selecting Downloads, and then 
RealSpeak Solo Direct Voices. 

5. After installing the synthesizer, WYNN software 
installation begins. You must accept the EULA agreement 
to continue installation. The setup program continues and 
installs WYNN based on the options you previously 
selected. Follow the installation instructions to complete 
installation. 

6. Finally, start WYNN by clicking the WYNN shortcut on the 
Windows Desktop. (The WYNN User Files folder is also 
added to the Desktop.)  
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Note:  The first time you launch WYNN after installation, you must 
complete software activation. It is intended to prevent 
software piracy and ensure that you are using licensed 
WYNN software. If you choose not to complete activation 
at this time, WYNN runs in 40-minute demo mode. When 
the 40-minute period expires, you must restart your 
computer to continue WYNN.  

Activating WYNN  

Note:  The following procedure assumes that your computer has 
Internet access. If you cannot connect to the Internet, refer 
to Activation Options on page 215 for more information.  

1. Open WYNN by clicking the WYNN desktop icon or 
selecting the WYNN program from the Start button.  

2. The WYNN Activation dialog box opens the first time you 

start WYNN. Click Activate. 
 

 

3. The WYNN activation options appear. Choose Now, 

using the Internet (Recommended), and click Next. 
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4. The Authorization Number edit box appears and contains 

your Authorization number. Click Next.  

Important:  

For NNMU installation, the Authorization Number edit box 
is blank. Enter the Authorization number that appears on 
the Authorization number label sheet into the edit box, and 

then click Next.  
 
For the single-user version, the Authorization number also 
appears on your WYNN product packaging. Type the 
number into the edit box if it does not automatically appear 
in the Authorization Number edit box.   

 

This process may take several minutes to complete. 
During this time, the Processing Request dialog appears. 
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You may be prompted to register your software. If you 
have not registered your software, you are asked to do so 
now. Registering lets you receive technical support. 

Choose Register Now and complete the online 
registration form by following the instructions provided.  

5. If the activation is successful, a confirmation message 

appears. Click Finished, which completes the activation.  

If the activation fails, a detailed error message appears 
that recommends you verify or reenter your authorization 
code, or that you contact Freedom Scientific for 
assistance. 

Uninstalling WYNN 

1. Click the Start button and choose All Programs. 

2. Open the WYNN <VersionNumber> submenu and choose 
Tools. 

3. Choose Uninstall WYNN <VersionNumber>. 
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WYNN Network Installation 

Network Installation Overview 

Note:  This chapter is intended for network administrators. It 
assumes that you are familiar with computer networks, 
user groups, user accounts, and user permissions. You 
must have Administrator or Power User access on all 
machines where the server, license server, and client 
components are installed. For license server and network 
details, see pages 229 and 234.  

Note: The WYNN Network program and the WYNN Stand-alone 
program are on the same DVD.  

Note: The WYNN software package downloaded from the 
Freedom Scientific Web site can be used to install a demo 
version of WYNN network or WYNN stand-alone. If you 
install using the downloaded software package, some of 
the installation instructions will be slightly different from the 
information in this chapter. 

Note:  You must uninstall any previous version of WYNN before 
installing the latest WYNN release. 

Note:  For a list of hardware and software requirements, see 
System Requirements on page 199.  

WYNN Network Installation consists of four major parts.  

¶ Installing the WYNN network server software (page 17).  

¶ Sharing folders and setting NTFS permission for the 
WYNNNet and Users folders (page 19).  

¶ Activating WYNN Network Server (page 26). This allows you 
to designate a computer running Windows on the network as 
the ILM license server. This computer issues tokens to the 
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WYNN clients. The number of license seats purchased 
determines the number of tokens available to client 
computers on the network.  

¶ Installing WYNN Network Client (page 31).  

Tip:  Make sure your user permissions are set up correctly or 
users may have problems saving their profiles, settings, 
and documents.  

Installing the WYNN Network Server  

Note:  When upgrading from an older WYNN Network version, 
disable the old Users share by right-clicking on the folder, 

selecting Properties, navigating to the Share tab, and 

selecting Do not share this folder. 

Network installation requires that you install all server components 
from the WYNN DVD to the server. During this process, all client 
installation files are copied to the server and several WYNN 
folders are created.  

1. Do one of the following: 

¶ If installing from the WYNN DVD, insert the DVD into 
the serverôs disk drive. (Both the network and stand-
alone versions of WYNN are on the same DVD.) 

¶ If installing from the downloaded software package, 
locate and double-click the executable file. The file has 

a name similar to WYNN[version number]-32bit-

64bit.exe. 

Important:  
WYNNôs server components installation program is located 
in the diskôs root folder. Installation must run from this 
location. Do not copy and run the installation components 
from a different medium. 
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2. The WYNN Setup program starts, and displays 
installation instructions. Follow these instructions to 
complete the WYNN installation.  

Note:  If the program does not start automatically run Setup.exe 
on the program disk.  

3. When prompted,  

¶ Choose Network WYNN installation 

¶ Choose a destination folder for Network WYNN. The 
default folder is C:\WYNNNet. If you want to install it in 

a different folder, choose Browse and select a new 

folder. Choose Next to continue with the installation.  

¶ Choose a location for users to share their documents 
and settings. The default document storage folder is 
C:\WYNNNet\Users. This location must be shared so 
that all users can access it. Make sure the storage 

location is shared and then select Next to continue.  

Note: The installation wizard can automatically share this folder. 
It will have Full Control permission for the Everyone group 
during installation and then will be demoted to Read Only 
permission for the Everyone group once installation is 

finished. Choose Yes to create this share or No to 
continue. 

4. When installation is complete, you can then set 
permissions for the folders referenced in the next section. 
Once that is complete, you can install WYNN Network 
Client on the workstations.   

Refer to page 31 for WYNN client installation procedures. 

During installation, several new folders and subfolders 
are created on the server (see page 236).  
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Configuring User Groups and Folder 
Permissions 

Users must be able to access certain folders to use Network 
WYNN. You can create one user group and set the access for that 
group, or you can create many users and then set the folder 
access for each user. 

Creating a User Group 

Create a WYNN user group to easily add students who will use the 
WYNN application. You can allow individual users to access the 
WYNN folders, but you will have to set folder permissions for each 
user. If you create a group, you only set folder permissions once 
for the group. 

1. Navigate to the Control Panel. 

2. Select Administrative Tools.  

3. Select Computer Management. The dialog box will vary 
based on your operating system as shown in the following 
images. 
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4. Expand Local Users and Groups and select Groups. 

5. In the Action menu (ALT+A) choose New Group or right-

click in the right panel and select New Group. 

6. Enter the Group name ("WYNN Users"). 
 

 

7. Choose Add to add members  

8. Click Create to create the group  

Sharing the Users and WYNNNet Folders 

After installing WYNN Network Server, and before installing 
WYNN Network Client, set the following permissions. 
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¶ Users. If the folder was not shared during installation, do so 

now and set permissions to Full Control, Change, and 

Read as described below.  

¶ WYNNNet. Share the folder and set permissions to Change 

and Read. 

To share the folders, follow these instructions: 

1. Use Windows Explorer to locate the folder.  

2. Next, right-click the folder and select Properties.  

3. In the Sharing tab, select the Share this folder option. 
The dialog box will vary based on your operating system 
as shown in the following images. 
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4. Select the Permissions button and choose Full Control, 

Change, or Read depending on which folder you are 
sharing.  

Note:  If you want the permissions to affect only the WYNN user 
group, add or select the group. While the group is selected, 
set the permissions. 

5. Select OK twice to close the Permissions and User 
Properties dialog boxes.  

Setting the NTFS Permissions 

You must also set NTFS permissions for the folders that WYNN 
users will access while using the WYNN Network Client. The 
NTFS permissions are: 
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¶ Users. Full Control as described below 

¶ WYNNNet. Read & Execute, List, and Read 

To set the NTFS permissions on the folders, follow these 
instructions: 

1. Use Windows Explorer to locate the folder.  

2. View the folder properties  

3. Select the Security tab. 

4. Select your WYNN User group.  

5. In the Permissions section, choose the permissions. The 
dialog box will vary based on your operating system as 
shown in the following images. 
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License Server Installation and Configuration 
Overview 

A WYNN Network Authorization CD is supplied with the Network 
WYNN version. The following overview describes the three 
primary steps to installing and configuring a license server 
computer.  

Note: If you do not install and activate the license server, the 
WYNN clients will operate in 40-minute demo mode. The 
WYNN software package downloaded from the Freedom 
Scientific Web site does not include the license server 
software. 
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¶ Select a license server computer 
 
You must designate one Microsoft Windows-based computer 
on the network to be the license server. This can even be 
the WYNN server. Install the license server on a networked 
computer that is not running the WYNN client. Make sure 
that this computer is always accessible.  
 
The license server handles requests for tokens. A token 
allows a WYNN client to use WYNN. The license server 
issues tokens to the requesting clients until there are no 
more tokens available. The number of available tokens 
depends on how many license seats were purchased. For 
example, if 10 seats are purchased, only 10 simultaneous 
WYNN sessions are available. If an eleventh computer tries 
to use the WYNN application, it is denied access to the 
application until a license seat becomes available.   

¶ Install the license server software 
 
The WYNN Network Authorization CD contains the network 
authorization utilities, documentation, and tools. Insert the 
CD into the computerôs disk drive, and follow the on-screen 
instructions to install the software.  

¶ Activate the license server computer 
 
This is the only computer that requires software activation. 
The other WYNN client computers do not require 
authorization or activation since they obtain tokens from the 
license server. For activation procedures, refer to Activating 
the License Server on page 27.   
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Installing the License Server Software and 
Network Authorization Tools 

The following process describes how to install the license server, 
which authorizes client computers to use your Freedom Scientific 
product. This installation also creates a program folder in your 

Start menu that provides access to the Network Authorization 
documentation and tools.  

1. To begin the installation, insert the WYNN Network 
Authorization CD into your computerôs disk drive. The 
Network Authorization Utilities dialog box appears. 

Choose Install to continue.  

Note:  If the installation does not begin automatically, run 
Setup.exe on the program disk.  

2. The Network Authorization Utilities installation status 
appears. The installation briefly pauses, and then 
launches the InstallShield Wizard for the SentinelLM 
Server.  

3. The InstallShield Wizard for SentinelLM Server starts. 

Choose Next to begin the license server installation. 

Note:  You can only install the license server on a computer that 
runs Windows XP or later. The license server does not 
support other operating systems such as Novell, UNIX, 
Linux, and so on.  

4. Read the license agreement. If you accept the terms and 

conditions in the agreement, choose Yes. 

By default, the license server installs in C:\Program 
Files\Rainbow Technologies\SentinelLM 7.2.0.6 Server. If 
you want to install the license server in a different folder, 

choose Browse and select a new folder. Choose Next to 
continue with the installation. 



Network WYNN Installation 

 

  27  

5. Choose Finish when installation of the SentinelLM Server 
is complete. The Network Authorization installation status 
menu appears again.  

6. Choose Finish when this installation of the Network 
Authorization Utilities is complete.   

The Network Authorization tools and license server are now 
installed. If you are using Windows XP, the ñSentinelLMò service is 
automatically added to your Windows Services.  

The installation creates a new folder in your Start menu called 

Freedom Scientific. View the Quick Reference section on page 
234 for detailed descriptions of each Network Authorization tool. 

Activating the License Server 

After installing the license server and Network Authorization tools, 
you must then activate your Freedom Scientific product license. To 
do this, you must request an Activation License code from 
Freedom Scientific. You can use the Internet to receive your 
Activation License code quickly and easily.  

Note: When upgrading from an older WYNN Network release, 
you must also update your authorization using the steps 
below. 

Perform the following to activate your Freedom Scientific product.  

1. From the Start menu, choose All Programs, Freedom 

Scientific, Network, and Update WYNN Wizard 

Authorization or WYNN Reader Authorization. 

2. Choose the Activate button to begin the activation.  

3. Select the Now, using the Internet (RECOMMENDED) 
option to specify that you want to use the Internet to 

acquire your Activation License code. Choose Next to 
continue.  
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4. Your 20-character Authorization number is automatically 

inserted into the Authorization Number edit box. If your 
Authorization number is not shown, type it into the edit 
box. (Your 20-character Authorization number appears on 

your WYNN disk package.) Choose Next to continue.  
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5. You may be prompted to register your software. 
Registering lets you receive technical support. Choose 

Register Now and complete the online registration form 
by following the instructions provided. You can choose to 
register later, but you must register the next time you 
activate the software on any computer. 

6. After you submit your registration, Internet License 
Manager (ILM) attempts to activate the software. This 
process may take several minutes. When the activation is 

successful, choose Finish.  

Tip:  If Internet License Manager cannot activate the software, 
you may need to reconfigure your firewall. See page 229 
for more information.  

7. Start the WLMAdmin utility by opening the Start menu 

and choosing Programs or All Programs, Freedom 

Scientific, Network, and Server Administration. If the 
WLMAdmin utility is running, quit the program and then 
restart it. You can use this utility to monitor where the 
license(s) reside and which users are using tokens. 

WYNN Network Client Overview 

The final part of network installation requires that you install the 
WYNN application onto the client computers by running the 
appropriate Setup.exe file that resides on the server. Do not run 
the client setup from the program disk.  

Note: If installing from the downloaded software package, locate 
and double-click the executable file. The file has a name 

similar to WYNN[version number]-32bit-64bit.exe. 

You do not need to perform additional authorization procedures for 
these computers. Each time the software is started on the client, it 
automatically searches for the license server and obtains an 
authorization token.  
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The number of tokens available depends on the number of users 
permitted by your license. For example, if you purchase a license 
for five users, your license server has five tokens available. Each 
time a user starts the software, the license server assigns the 
client computer a token. Once all tokens are assigned, no 
additional clients can receive authorization.  

If you need your license to support additional users, contact your 
local distributor or Freedom Scientific to purchase additional seats.  

To run the Setup.exe file from the server follow the procedures in 
the Installing the WYNN Network Client section. 

Adding the Environment Variable 
LSFORCEHOST 

Tip:  It is recommended that you add the environment variable 
LSFORCEHOST to the client computers and set it to the 
name or IP address of the SentinelLM license server. 
When the Freedom Scientific program starts, it will only 
search for a product license on the specified computer. If 
you have distributed the license over more than one 
license server and you want the program to search for the 
first available token, do not add this environment variable. 
For more information, refer to the System Administratorôs 
Guide, which is a Network Authorization tool that you 
installed earlier.  

Do the following to add the environment variable: 

For Windows 7, do the following: 

1. Click the Start button, right-click Computer, and choose 
Properties. 

2. In the left pane of the System dialog box, click Advanced 
System Settings. 
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3. In the Advance tab of the System Properties dialog box, 
click Environment Variables.  

4. Select the New button that appears in the System 
Variables area, and then enter LSFORCEHOST in the 
Variable name field and the server name or IP address in 

the Variable Value field. Click OK to close the dialog box 
and save the changes.  

For Windows XP, do the following: 

1. Click the Start button, right-click My Computer, and 
choose Properties.  

2. In the System Properties dialog box, select the Advance 
tab, and choose the Environment Variables button.   

3. Select the New button that appears in the System 
Variables area, and then enter LSFORCEHOST in the 
Variable name field and the server name or IP address in 

the Variable Value field. Click OK to close the dialog box 
and save the changes.  

Installing the WYNN Network Client  

Do the following to install the network client version of WYNN.  

1. From the client computer, use Windows Explorer to 
browse to the WYNN destination folder and run 
setup.exe. The default file location is:  

\\fileserver\WYNNNet\WYNN 6.0\Setup.exe, 

where fileserver is the name of the WYNN server. 

Note: If installing from the downloaded software package, locate 
and double-click the executable file. The file has a name 

similar to WYNN[version number]-32bit-64bit.exe. 



Network WYNN Installation 

 

32   

Note:  Make sure you use the UNC share path 
(\\fileserver\WYNNNet\...). This is the path that WYNN will 
use to connect to the WYNN server. 

2. The WYNN setup program starts and displays installation 
instructions. 

3. When prompted,  

¶ Choose installation for WYNN Wizard, WYNN Reader, 
or both.  

¶ Choose the language locale, for example, U.S. English 
or another language. 

¶ If the public domain books are available, choose to 
install these books.  

4. Next, the setup program installs the RealSpeak Solo 
Direct speech synthesizer. Accept the End User License 
Agreement and continue to follow the installation 
instructions. (This synthesizer is not available for the 40-
minute demo version downloaded from the Web.) 

Note:  For certain installations, such as an upgrade, it may be 

necessary to reboot your computer. Click Yes when 
prompted if this is the case.  

5. Click Finish when the install is complete. 

The WYNN application is installed, and the WYNN 
application folder icon appears on the clientôs desktop.    
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Getting Started 

This section describes basic tasks that all users can perform to 
start WYNN, open documents using WYNN, read documents with 
WYNN, use WYNN's study tools, customize WYNN, and save 
documents using WYNN.    

Starting WYNN 

The first time you start WYNN, you must create a unique user 
name before using the software. Not only does this process create 
your user name, but it also creates your own user folder, which is 
your default folder that stores your documents. The default folder 
uses your user name. For network versions of WYNN, your default 
user folder is stored on the server. 

To start WYNN: 

1. Double-click the WYNN Wizard or WYNN Reader 
application icon on your desktop.   

The User Log-In dialog opens.  

2. If you already have a user name,  

¶ Select it from the list, and click OK. The WYNN 
application starts, and opens either a blank document, 
or the last file that was open.  

If you are a new user, 

¶ Type your name in the Please Sign In Here box. 

¶ Click OK.  

¶ A confirmation window appears. Click Yes. A process 
begins that accepts your new user name, creates a 
default folder for your documents, and starts the 
WYNN application.  
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¶ The WYNN application starts, your user name appears 
in the upper right corner of the WYNN window, and the 
Welcome to WYNN file opens.  

Multi-User Log In 

If another user wants to log in without quitting WYNN: 

1. Choose Log Off <user name> from the File menu or 
click on the name in the upper right corner.  

2. A confirmation message appears. Click Yes. 

3. The user can then log in, as previously described, and 
begin using WYNN. 

Note:  If only one user will be using WYNN on this computer, you 

can skip the log in process. To do this, choose Enable 

Multi-User Logins from the File menu. Enable Multi-User 

Logins should be unchecked. The next time you start 
WYNN, you will not be asked to log in. Choose this 
command again to re-enable multi-user logins. 

Creating a New Document 

To create a new document: 

1. From the blue File Management toolbar, click the New 
button. 
 

  

A blank page appears. You can type new text into this 

document, or click the Scan button to add acquired pages 
to it. 

Tip:  You can also press CTRL+N to create a new document. 
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Note:  By default, the maximum number of documents that can be 
open at once is two. If you create a new document while 
the maximum number of documents is already open, 
WYNN asks you to save changes to the least recently 
accessed document and then closes it.  
 
To change the number of documents you can have open, 
see Increasing the Number of Open Documents on page 
40. 

Opening an Existing WYNN Document 

To open an existing document: 

1. From the blue File Management toolbar, click the Open 
button. 
 

  

The Select a File to Open dialog appears. All WYNN 
formatted files saved in your user folder appear. WYNN 
files use the WYX and OBX file extensions. 

2. Locate the file on your computer, and then click Open to 
load the file.  

If the file you want to open is not shown in the list, use the 

Look In combo box to locate and select a different folder.  

When you reopen a document (WYX or OBX), it always 
opens to the last page that you were reading. When you 
reopen a legacy document (WYN or ARK), it always 
opens to the first page of the document. You can resolve 
this by saving the file in WYX or OBX format.   
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Opening Other Documents 

To open files saved in file formats other than WYNNôs default 
format: 

1. From the Files of type combo box, choose one of the 
following file formats that can be read by WYNN.  

¶ WYNN (WYX) and OpenBook (OBX) 

¶ Legacy WYNN (WYN) and OpenBook (ARK)  

¶ Portable Document Format (PDF) ï WYNN Wizard 
only 

¶ Text (TXT) and DOS Text  

¶ HTML (HTM)  

¶ Rich Text Format (RTF)  

¶ DAISY (XML, OPF, NCC.HTML)  

¶ Audio (MP3, MPG, WAV, WMA, CDA) 

¶ Image (TIF, TIFF, JPG, JPEG, PCX, BMP, GIF, PNG) 

¶ Bookshare.org (BKS, BKS2) 

¶ WordPerfect (WPD) 

2. Select the file you want to open. 

3. Click Open. 

When you open a PDF file in WYNN, it becomes available 
just as if you had scanned it in.  

When you open other file types, WYNN displays the 
contents of these files in the Text View without any 
special formatting.  
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To view these files in their original format, open them in 
the program they are normally associated with. 

Tip:  You can also press CTRL+O to open a file. 

Note:  By default, the maximum number of documents that can be 
open at once is two. If you create a new document while 
the maximum number of documents is already open, 
WYNN asks you to save changes to the least recently 
accessed document and then closes it.  
 
To change the number of documents you can have open, 
see Increasing the Number of Open Documents on page 
40.  

Note: If you later navigate away from the default file folder 

location, you can use the User Docs button (which is a 
shortcut) in the Open dialog box to quickly return to your 
default file folder (Docs). 

Opening Files Using the WYNN User Files 
Shortcut 

After installing WYNN, the WYNN User Files shortcut appears on 
your desktop. It provides fast access to the files in your default 
WYNN folder.  

To open a document using your WYNN Documents shortcut: 

1. From the Windowsô Desktop, double-click the WYNN 

User Files shortcut. The folder that opens contains your 
personal default folder and WYNNôs Shared file folder. 
Your default folder is located in, 

C:\Users\Public\Documents\WYNN\[version 

number]\[login name]\Docs, or  
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C:\Documents and Settings\All 

Users\Documents\WYNN\[version number]\[login 

name]\Docs (for Windows XP) 

2. Open your default folder to access your saved files.  

Creating WYNN Files Using the Freedom 
Import Printer 

WYNN Wizard includes a virtual printer that provides the ability to 
convert files from PDF files, or any other file format, to a WYNN 

document. This virtual printer, called the Freedom Import Printer, 
shows up on the list of printer drivers in the Print dialog box.  

The following topics provide example for opening a PDF formatted 
file and converting it to a WYNN (WYX) formatted file using the 
Freedom Import Printer and WYNN Wizard.   

Opening a PDF file from within WYNN  

There are two ways to bring PDF files into WYNN Wizard: 

¶ The first is to open the PDF file from within WYNN 

¶ The second is to open Adobe Acrobat Reader and print the 
PDF using the Freedom Import Printer. This conversion 
process is described in Converting Files Using the Freedom 
Import Printer.  

To open a PDF using WYNN, do the following: 

1. Start WYNN.  

2. From the File menu, choose Open. The Select a File to 
Open dialog appears.  

3. Change the "Files of type" field to Adobe PDF 
Documents.  
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4. Select the PDF file you want, and click the Open button. 
The file is automatically converted to the WYNN file 
format.  

Converting Files Using the Freedom Import 
Printer 

You can also convert PDF document, or documents from any 
other file format, into WYNN documents using the Freedom Import 
Printer. The Freedom Import Printer is only available in WYNN 
Wizard.  

Note:  This process also works for converting online PDF files.  

1. From any application, open a file you want to open with 
WYNN Wizard.  

2. From the File menu, choose Print. Select Freedom 

Import Printer as your printer.  

3. If desired, specify the range of pages to be "printed."  

4. Select OK.  

5. The Freedom Import Printer will convert the document 
to a WYNN file.  If WYNN is not open, the Virtual Printer 
will open it. You may wish to save the file as a WYX file 
after it is opened in WYNN.  

Switching Between Files Using File List  

You can use the left side navigation pane to switch between open 
documents. It shows all of your open documents arrange by type.  

1. Click the File List button.  
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2. Select the title of the document that you want to view.  

If you right-click on a selected title, you can close the 
document or have WYNN speak its name. 

  

Increasing the Number of Open Documents 

By default, WYNN allows a maximum of two documents to be 
open at once. 

To change this setting, do the following: 

1. Click Settings from the WYNN menu bar, and click the 

General Settings command. The General Settings 
property page opens.  

2. Select or type a value in the Maximum Number of Open 
Documents combo box. 
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3. Click OK. 

Acquiring a Document into WYNN  

The acquisition (scanning) feature allows you to read and work 
with printed materials in WYNN. You can create a new document 
based on an acquired page or insert acquired pages into existing 
documents. You can also replace existing pages with acquired 
pages. For additional acquisition information, refer to the 
Acquiring/Scanning with WYNN section on page 111. 

Note:  You can only acquire documents using WYNN Wizard. 
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Device Selection 

Note:  WYNN automatically detects the camera and scanner 
drivers that are installed on your computer, and selects one 
to use as the default. The first time you acquire a 
document; the software displays a message asking you to 
confirm the acquisition device selection. If you want to 
change the device, do the following. 

1. From the Advanced menu, choose Device Selection.  

2. In the Acquisition Source box, select Scanner or PEARL 
Camera.  

3. If you select Scanner as the acquisition source, select a 
scanner from the Device box.  

4. If necessary, select Properties to fine tune device 
settings. 

5. Click OK to save device selection and close the dialog 
box, or Cancel to close without saving changes.  

Acquiring a Page and Making a New Document 

To acquire a page and create a new document: 

1. Place the page you want to acquire face-down on the 
scanner, or face-up under the PEARL camera. If 
necessary, refer to your scanner or camera's 
documentation for more information about your device. 

2. Click the Scan button on the blue File Management 
toolbar.  
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WYNN acquires the page, recognizes the text, and 
displays a new document containing the acquired text. 
This is known as Text View. 

Note:  If you acquire a page into an existing document, WYNN 
automatically appends the page to the end of the current 
document. For more information about acquiring pages into 
existing documents, see Acquiring and Inserting a New 
Page below or Acquiring and Replacing the Current Page 
on page 44.  

Note: To stop an acquisition in progress, press ESC at any time. 

3. To see the original version of the page, click the Exact 

View button. 
 

 
 

To return to the text version, click the Text View button.  
 

  

4. To see both Exact View and Text View, click the View 
menu, and then choose Split View. 

Acquiring and Inserting a New Page 

When acquiring a page into an open WYNN document, WYNN 
automatically adds the page to the end of the document. To insert 
the new page in another part of the document, do the following: 

1. Click the Open button on the blue File Management 
toolbar, and open the document that you want to add the 
new page to.  

2. Move your cursor to the location where you want to insert 
the page.  



Getting Started 

 

44   

Important:  
The acquired page appears before the selected page. For 
example, if you want to insert the new page between pages 
10 and 11, place your cursor on page 11 before scanning 
the page.  

3. Place the page you want to acquire facedown on the 
scanner, or face up under the PEARL camera. Refer to 
your deviceôs manual for more information on page 
placement. 

4. From the Acquire menu, choose Acquire and Insert New 

Page.  

WYNN acquires the page and recognizes the text. It also 
inserts the new page before the page where you placed 
the cursor. 

Note: To stop an acquisition in progress, press ESC at any time. 

Acquiring and Replacing the Current Page 

To replace a page in a WYNN document with a newly acquired 
page: 

1. Click the Open button on the blue File Management 
toolbar, and open the document that you want to add the 
new page to.  

2. Move your cursor to the page you want to replace. 

3. Place the page you want to acquire facedown on your 
scanner, or face up under the PEARL camera. Refer to 
your deviceôs manual for more information on page 
placement. 

4. From the Acquire menu, choose Acquire and Replace 

Current Page.  
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5. WYNN acquires the page and recognizes the text. WYNN 
deletes the page where your cursor is located and 
replaces it with the acquired page. 

Note: To stop an acquisition in progress, press ESC at any time. 

Reading a Document 

WYNN can read a document or Web page aloud and ñspotlightò 
the spoken words as you read along.  

To read a document: 

1. Open a document or Web page.  

2. Select a starting point by clicking a word. The spotlight 
appears on that word.  

For example,  

 

Tip:   To change the appearance of the Spotlight, go to the 

Settings menu and navigate to the Visual Settings tab. 

3. Click the Read button. 
 

  

WYNN reads the document aloud and moves the 

spotlight along as it reads. In addition, the Read button 

switches to the Pause button.  
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4. To stop reading, click the Pause button.  
 

 

5. To start reading again from the current cursor position, 
click the Read button.  
 

 

To change the way WYNN pronounces certain words, refer to 
Adding Words to the Pronunciation Dictionary on page 135. 

Tip:  You can also press F2 or choose Start Reading from the 

Tools menu to start reading. 

Skim Reading 

The Skim Reading feature lets you quickly browse through long 
documents by reading the first sentence, last sentence, or both of 
each paragraph in a document. If you are in the middle of a 
paragraph, WYNN  will finish reading the current sentence and 
then jump to the next sentence base on your selection of First 
Sentence, Last Sentence, or First and Last Sentence. 

To start skim reading, 

1. Press SHIFT+F2, or click Skim Reading from the Tools 
menu. 

2. To stop reading, press ESC. 

3. To restart skim reading, press SHIFT+F2 again. 

To change skim reading options, 

1. Click the Settings menu, and then Speech Settings. 
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2. In the Skim Reads Speaks Paragraph list box, select 
First Sentence, Last Sentence, or First and Last 
Sentence. 

 

3. Click OK to apply changes and close Speech Settings. 

Switching Between Exact View and Text View 

When you acquire a document, the WYNN system creates two 
versions: an exact image view, and a text only view.  

¶ The exact image view shows the document exactly as it 
appears in the original.  

¶ The text only view extracts only the text from the acquired 
document. Text Only mode is the default view after scanning 
a document.  

To switch between Exact View and the Text View:  

1. Click the Exact View button to view the current document 
in its original form, which may be an acquired image, PDF 
file, Microsoft Word document, or any other supported file 
format.  
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For example: 

 

In Exact View, you can read the text as it appears in its 
original format, or zoom-in to enlarge the entire image 

(using the View menu). If the document was acquired in 
Black and White, you can also change the background 
color.  

When in Exact View, this button changes to the Text 

View button. 

2. Click the Text View button only to see the text of the 
page, without formatting, graphics, line art, tables, and 
columns. 
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For example:  

 

While in Text View, you can edit the text or use any of 
WYNN's visual modifications from the green toolbar to 
change how the text appears.  

Two-tone Exact View Mode 

Use Two-tone mode to apply text and background colors to a color 
or grayscale image in both Exact View and Split View. The default 
setting for this option is off, which means that changes made to 
the text colors will only apply to the Text View, or the Text View 
area of Split View.  

Note: This setting is not available if the open document does not 
have an Exact View, or the Exact View image is in black 
and white. 
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To turn on Two-tone mode:  

1. Open a document that contains an Exact View color or 
grayscale image.  

2. Click the Settings menu, and then Visual Settings.  

3. Select the Use Two Tone for Exact View check box.  

4. Click OK to apply changes and close Visual Settings. 

When on, you can change the text and background colors 
and apply them to any open color or grayscale 
documents in Text View, Exact View, and Split View. 

To quickly switch Two-tone mode on or off, 

¶ Click the View menu, and then click Two Tone, or  

¶ Press CTRL+2.  

Opening Multiple Voice Notes and Text Notes 

You can insert Voice Notes and Text Notes throughout a 
document to provide key information, instructions, and questions 
about specific passages of text. You can also insert multiple Text 
and Voice Notes at the same location in a document. When this is 
done, the notes appear side-by-side in Text View mode.  
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However, in Exact View mode the notes appear as a single Text 
Note or Voice Note icon. 

 

To determine if one or more notes appear at a particular location 
in a document while using Exact View mode, do the following: 

1. Place your mouse pointer over a Text Note or Voice 

Note icon, and right-click on the icon. A popup menu 
appears.  
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If the Edit Note (select) command appears with a right 
arrow, this indicates the presence of multiple notes. If 
there is only a single note at that particular location, the 
right arrow does not appear.   

 

2. Click the Edit Note (select) command to view, and select 
a specific note.  

The Text Annotation or Voice Annotation dialog appears 
depending on the type of note selected.  

3. Click Stop or Cancel to close the Voice Annotation 

dialog, or click OK to close the Text Annotation dialog.   

4. Repeat steps 1-3 to open more notes.  

For more information, refer to Creating a Text Note on 
page 158 and Creating a Voice Note on page 156.  
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Changing the Speech Rate 

You can increase or decrease WYNNôs rate of speech to a setting 
that is comfortable for you. There are two ways to do this by using 

either the Rate button on the green Reading Styles toolbar to 

quickly change the speech rate, or the Speech Settings 
command on the Settings menu for a more precise speech rate.  

Using the Rate Button  

To change the speech rate: 

1. Click the Next button until the green Reading Styles 
toolbar appears.  
 

 

2. Click the Rate button. 
 

 

The Rate button has five speech rate settings. The 
settings may vary according to your speech synthesizer, 
but are usually: 

¶ 130 words-per-minute (WPM) 

¶ 160 WPM 

¶ 190 WPM 

¶ 220 WPM 

¶ 250 WPM 

3. Continue to select the Rate button until you are satisfied 
with the speech rate.  
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Using the Speech Settings Command 

To select a more precise speech rate: 

1. From the Settings menu, click Speech Settings.  

 

2. Select the Rate slider and move it left or right to decrease 
or increase WYNNôs speech speed. The speech rate 
appears in words-per-minute (WPM). 

3. Click the Test button to listen to the new setting, and then 
make any necessary adjustments.  

4. Click OK to accept the change, or click Cancel to restore 
the previous settings.  
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Changing Line and Word Spacing 

To enhance readability when in text view, you can change the 
amount of spacing that appears between words and lines in a 
paragraph.  

To increase line spacing: 

1. Click the Next button until the green Reading Styles 
toolbar appears.  

 

2. Click the Line Space button. 
 

 

The spacing between lines of text increases.  

3. If necessary, continue to click the Line Space button until 
you are comfortable with the spacing. You can cycle 
through six preset line space settings using this button. 

Note:  Any changes made to these settings are automatically 
saved upon exiting the application. When you log in again, 
the last used settings are automatically loaded. 

To increase word spacing: 

1. From the green Reading Styles toolbar, click the Word 

Space button.  
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The spacing between words increases. You can cycle 
through six preset word spacing settings. 

2. If necessary, continue to click the Word Space button 
until you are comfortable with the spacing.  

Note:  Any changes made to these settings are automatically 
saved upon exiting the application. When you log in again, 
the last used settings are automatically loaded. 

Tip:  To make changes to the visual settings beyond what is 
offered on the green Reading Styles toolbar buttons, go to 
Settings, and then choose Visual Settings.  

Saving a Document 

To save a document in WYNN: 

1. From the blue File Management toolbar, click the Save 
button. 
 

 

If the file is new, the Select a file to Save to dialog 

appears. Enter a file name and click Save.  

If a file with the same name already exists in the selected 
folder, WYNN asks you if you want to overwrite the 
existing file.  

2. Click the OK button to replace the existing file.  

Click the Cancel button if you do not want to overwrite 
the file. 

If you later navigate away from the default file folder 

location, you can use the User Docs button to quickly 
return to your default file folder (Docs). 
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To save a new document, or to save an existing document with a 
new name: 

1. From the blue File Management toolbar, click the Save 

As button.  
 

 

The Select a file to Save to dialog box appears.  

If you want to save the file in a different format, click the 

Save As Type combo box. This allows other programs, 
such as Microsoft Word, to read this file. 

 

If you want to save the file in a different folder on your 

computer, locate and select the folder using the Save In 
combo box. 

2. Enter a file name into the File name edit box, and click 

the Save button. 

Adjusting Speech 

You can adjust the speech settings so you can determine how 
much feedback you receive, which makes it easier to distinguish 
where and what WYNN is reading. 
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Selecting Voices 

You can assign different voices for reading and editing text, 
speaking menu and dialog box items, and reading text that has 
emphasis such as underline, italic, or bold. This helps distinguish 
what is being read. After selecting the type of reading voice, you 
can customize and adjust items such as volume and reading 
speed for each voice.   

To select and adjust voices: 

1. Click the Settings menu, and then Speech Settings.  

2. In the Voice Selection combo box, select the voice you 
want to modify. 

Your choices are: 

¶ Reading Voice ï The voice used to read and edit text. 

¶ Menu Voice ï The voice used to read menus and 
dialog boxes. 

¶ Emphasis Voice ï The voice used to read text that is 
bold, underlined and in italics. The Emphasis Voice 
also reads bookmarks when the Announce Bookmarks 
check box is selected.  

Note: In order to recognize text that is bold, underlined, and in 
italics, you must enable the Use Emphasis Voice for Bold, 
Etc. check box in the Process page for the selected 
workflow.  

3. Check the Apply Settings to All Voices check box if you 
want to globally apply your voice setting changes for one 
voice to the other voices. 
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4. Next, in the Menu Voice Settings group, use the 

Synthesizer, Language, Name, Rate, Volume, and 

Punctuation options to customize the Reading Voice, 
Menu Voice, or Emphasis Voice. You can experiment with 
these adjustments until you find the settings you like.  

A description of each option is described after the steps in 
this procedure.   

5. Click the Test button to test any voice modifications (rate, 
volume, and so on) that you have applied. To stop the 
test, click the button again.  

Note: If you decide that you do not want to hear speech at all, 
clear the Enable Speech check box. This turns off speech. 

6. Last, if you want to make more changes, click the Apply 

button to save the current settings, or click Ok to save 
and close Speech Settings.  

Synthesizer 

The Synthesizer combo box lists the different speech drivers you 
can choose from. The following choices are available: 

¶ RealSpeak Solo Voices ï RealSpeak Solo Direct voices 
offer responsive, high-quality, human-like speech and will 
appear in the Voice Name combo box when you select this 
option. This selection is not available until you have installed 
at least one RealSpeak Solo Direct voice. 

¶ SAPI 5 ï Select this option to use any SAPI 5 compatible 
voice installed on your computer. This includes the Microsoft 
voices that come with Microsoft Windows as well as third-
party synthesizers that you purchase. Once you select this 
option, the available SAPI 5 voices are listed in the Voice 
Name combo box.  
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Note: You can only select a synthesizer for the Reading and 
Menu voices. If the Emphasis voice is selected, this combo 
box is not available. When you select the synthesizer for 
the Reading voice, the same selection is also used for the 
Emphasis voice. 

To change synthesizers: 

¶ Click the Synthesizer combo box, and click a synthesizer in 
the list.  

Language 

The Language combo box lists the available languages depending 
on whether you are using RealSpeak Solo Direct or SAPI5. The 
available languages will vary depending on the selected 
synthesizers.  

To change the voice language, 

1. Click the Language combo box, which displays a list of 
available languages. 

2. Click a language in the list.  

Name 

The Name combo box allows you to select which voice is used. It 
is helpful to have different voices selected for the Reading, Menu, 
and Emphasis voices. You then immediately know the source of 
information spoken by WYNN. 

The voices available in this combo box will depend on whether you 
are using RealSpeak Solo Direct or SAPI 5. 

To change the voice name: 

¶ Click the Voice Name combo box, and select a name from 
the list.  
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Rate 

To adjust the rate of the current synthesizer: 

¶ Move the slider to the left to slow down the reading voice, or 
move the slider to the right to speed up the reading voice. 
Voice rate is measured in words per minute and ranges from 
40 WPM to 460 WPM.   

Volume 

To adjust the volume of the currently selected synthesizer, 

¶ Move the slider to the left to decrease voice volume. Move 
the slider to the right to increase voice volume. 

Punctuation 

Use this to determine how much punctuation is announced while 
reading. Your choices are: 

¶ All ï WYNN speaks every punctuation symbol. 

¶ Most ï WYNN speaks the most commonly used punctuation 
such as periods and commas. 

¶ Some ï WYNN speaks the less common punctuation and 
does not speak periods and commas. This setting is the 
default for the Reading and Emphasis voices. 

¶ None ï No punctuation is spoken. This is the default for the 
Menu voice. 

Note:  The amount of punctuation you hear is unique to each 
synthesizer.   

To select Reading Voice Punctuation:  

¶ Click the Punctuation combo box, and select an option from 
the list.  
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Other Speech Settings 

The following describes other available Speech Settings options 
that you can use for Reading Voice, Menu Voice, and Emphasis 
Voice.   

Capital Letters While Typing 

¶ Select this check box if you want WYNN to announce capital 
letters while typing. 

¶ Clear this check box to turn off the announcement of capital 
letters while typing.  

Numbers as Single Digits 

When this check box is selected, WYNN reads numbers as a 
series of single numbers. For example, 123 is read ñone two 
three.ò This option is off by default. 

Headers and Footers 

Select this check box to have WYNN read the header and footer 
for each page. Clear the check box if you do not want headers and 
footers announced when reading. This option is on by default. 

Use Emphasis Voice for Bold, Etc.  

Select this check box to indicate words that appear in the 
document as bold, italic, or underlined text by using a different 
voice. When selected, you should also modify the Emphasis Voice 
so that you can hear a difference between the Reading and Menu 
Voices.  
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Text, Menus and Dialogs, Messages, Toolbar 
Buttons  

If you want more feedback on the type of controls you encounter 
while using WYNN, select these check boxes. WYNN announces 
these items as they appear, or as focus moves over the item. To 
turn off feedback, clear these check boxes.  

Extra Pause after Each Line 

Use the options in this combo box to control the length of time that 
speech is paused after reading a line. Select the amount of time to 
pause, ranging from 0 to 3 seconds.  

Read Aloud as I Type 

Use this option to modify what feedback you receive (or is echoed) 
while you are typing text in a document in Edit mode.  

To change typing feedback:  

1. Click the Read Aloud as I Type combo box, and select 
the echo you want during editing.  

Your choices are: 

¶ Character - Speaks every keystroke as you type. 

¶ Word - Speaks only completed words; that is, it 
speaks the word you just typed as soon as you type 
punctuation or a space after it. 

¶ Character and Word ï Speaks both the keystrokes as 
you type and the final completed word after you type it. 
This is useful for beginning typists or with material you 
are proofreading. 

¶ Sentence ï Speaks the complete sentence after you 
type it. 
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¶ Word and Sentence ï Speaks both the completed 
word and the sentence after you type it.  

¶ Off - Does not echo any keystrokes. 

Skim Read Speaks Paragraph 

Skim reading allows you to read the first sentence, last sentence, 

or both of each paragraph in a document. Press SHIFT+F2 to start 
skim reading. If you are in the middle of a paragraph, WYNN will 
finish reading the current sentence and then jump to the next 
sentence based on your selection of First Sentence, Last 
Sentence, or First and Last Sentence. 

Check for Updates 

Freedom Scientific is continually seeking to improve and expand 
WYNN. Periodically, WYNN updates are released, so it is 
recommended that you keep your software up to date.  

To check for updates after installing the WYNN release, do the 
following: 

1. Click the Help menu and then Check for Updates. 

2. The update feature determines if you have the most 
current release. If you do not, select one or more items 

from the list and then select INSTALL to begin the 
update.  

If your version is up to date, the update feature displays a 
message indicating that you have the latest version. 

Note: The network version of WYNN does not support the Check 
for Updates feature. 
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Getting to Know WYNN 

This section provides a description of various parts of the WYNN 
screen, which includes:  

¶ User Interface  

¶ Toolbars, see page 66 

¶ Menu Bars, see page 91 

WYNN User Interface 

 

1. Title Bar. Displays the name of the open WYNN file.  

2. WYNN Menu Bar. All WYNN commands are available 
using these menus. 
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3. WYNN Toolbars. This row of buttons contains the 
common toolbar buttons and the current toolbarôs buttons. 
The primary toolbars are the blue File Management 
toolbar, the green Reading Styles toolbar, the pink Study 
Tools toolbar, and the yellow Writing Tools toolbar.  

4. File List. The left side navigation pane displays the 
names of all open documents, including Web pages. Click 

the File List button to open and close the pane. 

5. Cursor and Page Locator. Indicates which line the 
cursor is in, and it indicates which page is currently in 
view.  

6. Spotlight Text. When in Read mode, the cursor position 
appears as spotlighted text.  

7. Document Work Area. Your document appears in this 
scrollable area.  

8. User Name. Shows you who is currently logged in to the 
WYNN system.  

WYNN Toolbars 

WYNN's toolbars provide quick access to many different 
commands. There are four primary toolbars, each with different 
colors and buttons. In addition, there are several buttons available 
on each toolbar: the Next, Read/Pause, Write/Read-Only, Exact 
View/Text View, and File List buttons. Each toolbar is described 
below. 

Tip:  From the Settings menu, choose Custom Toolbar to 
create a customized toolbar with the commands you use 
most often. Refer to the topic Creating a Custom Toolbar 
on page 145 for more information. 
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Common Toolbar Buttons 

The Common Toolbar buttons always appear as the first five 
buttons from left to right on the WYNN screen. Use these buttons 
to: 

¶ Switch from one toolbar to another 

¶ Start or stop WYNN from reading aloud 

¶ Edit a document 

¶ View a document in its original formatted state or as text 

¶ Open File List and switch between open WYNN documents  

Next 

 Click the Next button to cycle through WYNN's four color-
coded toolbars. The color of the bar at the top of the button 
indicates which toolbar will display when you click the button. The 
color of the up arrow indicates the active toolbar. 

Read / Pause 

    When you click Read, WYNN reads the document 
aloud and moves the spotlight along as it reads. While WYNN is 
reading, this button changes into the Pause button.  

Click the Pause button to stop reading. Click Read again to 
resume reading from the current cursor position. 
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Write / Read Only 

    Click Write if you want to edit or make additions to 
the text of the current document. This button is not available in 
Exact View, and changes you make in Text View are not visible in 
Exact View.  

When the document is in Write mode, this button changes into the 

Read Only button. Click the Read Only button to return to Read-
only mode. You cannot write or edit text in Read-only mode. 

Exact View / Text View 

    Click the Exact View button to see the current 
document in its original form, which may be an acquired image, 
PDF file, Microsoft Word document, or any other supported file 
format. While in Exact View, you can zoom (using the View menu), 
read text, and change text and background colors if the document 
was acquired in black and white mode. You cannot make any 
changes to the actual document text. 

When in Exact View, this button changes to the Text View button. 

Click the Text View button to see just the text of the page, without 
any formatting, including graphics, line art, tables, and columns 
that affect how the page appears. While in Text View, you can edit 
the text or make modifications to how the text looks using the 
green toolbarôs Visual settings buttons.  

File List  

 Click the File List button to open the left-hand navigation 
panel. You can then switch between your open documents. The 
maximum number of documents you can have opened is 

determined in General Settings in the Settings menu. 
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You can also use the Window menu to switch between open 
documents. Either select the document you want to switch to from 

the menu or choose Next Document. 

File Management Buttons 

Use the blue buttons on this toolbar to scan (acquire), create, 
open, close, print, and save documents. You can also use this 
toolbar to access WYNNôs document clean-up function and the 
Internet. 

 

Scan 

 Place a page face-down on your scanner, or face-up 

under the PEARL camera, and click the Scan button to begin 
acquiring (scanning). WYNN scans the page, recognizes the text, 
and displays it in Text View. You can interrupt the scanning 

process by clicking the Cancel button. If you acquire additional 
pages, WYNN inserts these new pages after the page the last 
page acquired. 

In order to acquire a document directly into WYNN, you must use 
WYNN Wizard and have previously installed your scanner. You 
cannot acquire documents if you are using WYNN Reader or have 
not installed a scanner or connected a PEARL camera. 

Tip:  To change Scan preferences, choose Workflow Settings 

from the Settings menu. To use a different scanner or 

driver, choose Device Selection from the Advanced 
menu. 
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New 

 Click the New button to create a new WYNN document. 
You can type new text in this document or acquire new pages in it.  

If you create a new document while the maximum number of 
documents is already open, WYNN asks you to save your 
changes to the document you have accessed the least recently 
and then closes it. To change the number of documents you can 

have open, choose General Settings from the Settings menu. 

Tip:  You can also press CTRL+N to create a new document. 

Open 

 Click the Open button to open an existing file in WYNN. 
Locate the file on your computer and then click Open to load the 
file. If the file you want to open is not in the list, use the Look In 
combo box to select a different folder. See page 37 for the location 
of user files. 

You can open other types of files using either WYNN Wizard or 
WYNN Reader by making a new selection in the Files of Type 
combo box. WYNN can read legacy WYNN (.wyn), Microsoft Word 
(.doc), text (.txt), HTML (.htm), rich text format (.rtf) files and more. 
WYNN Wizard can also open PDF files. When you open a PDF file 
in WYNN Wizard, it becomes available just as if you had acquired 
it in. When you open files of other types, WYNN displays the 
contents of these files in the Text View without any special 
formatting. To view these files in their original format, you should 
open them in the program they are normally associated with, and 
then print them to WYNN using the Freedom Import Printer driver. 
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If you create a new document while the maximum number of 
documents is already open, WYNN asks you to save your 
changes to the document you have accessed the least recently 
and then closes it. To change the number of documents you can 

have open, choose General Settings from the Settings menu. 

Tip:  You can also press CTRL+O to open a file. 

Close 

 Click the Close button to close the active document. If 
you have made any changes or added mark-ups to the document, 

WYNN asks you if you want to save them. Click Yes to keep your 

changes. Click No to discard your changes. WYNN automatically 
saves any additional pages you have acquired and added to the 
document. 

Tip:  You can also press CTRL+W to close a document. 

Save 

 Click the Save button to save changes to your document. 
WYNN saves the document using the current file name and 
location. 

Save As 

 Click the Save As button to save your document with a 
new file name and/or location. After you click this button, enter a 

new name for the file in the File Name edit box. You can save the 

file in a different format by making a new selection in the Save As 

Type combo box. This allows other programs, such as Microsoft 
Word, to read this file. If you want to save the file in a different 

folder on your computer, select the folder in the Save In combo 
box. 
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Click Save to save your document using the new name and/or 
location. If a file with the same name already exists in the folder 
you selected, WYNN asks you if you want to overwrite the existing 

file. Click OK to replace the existing file. Click Cancel if you do not 
want to overwrite the file.  

Print 

 Click the Print button (CTRL+P) to print the active 
document. Choose the printer you want to use to print the 
document. Then specify which parts of the document you want to 

print and the number of copies you want to create. Click OK to 
begin printing. You can choose to print only text that you have 
highlighted in the document by selecting the Highlight Text Only 
radio button. You can also choose to print only the content of all 

text notes in the document by selecting the Text Notes Only radio 
button. For more information on these features, refer to the 
Highlight and Text Note buttons on pages 79 and 82. 

Clean-up 

    The Clean-up feature (also known as Document 
Clean-up) corrects any scanning or OCR errors that occur during 
document scanning.  

When you click Clean-up, your acquired document appears in a 
split-screen view that shows text in the upper half and the 
acquired image in the lower half.  

Note:  Click No Clean-up, and your screen returns to its previous 
whole-screen view (text or exact). 

For more information and procedures, see Document Clean-up on 
page 125. 
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Tip:  You can also press SHIFT+F7 to enter and exit Document 
Clean-up 

Go To Web 

 Click the Go To Web button to begin browsing the 
Internet. You can also open a new Web document. 

For more information on WYNN's Web features, refer to the help 
topic Browsing the Web Using WYNN on page 160. 

Reading Styles Toolbar 

Use the green buttons on this toolbar to change the way 
documents appear visually and audibly in WYNN. You can use 
this toolbar to change the text size, word and line spacing, page 
margins, text and background color combinations, speech rate, 
masking settings, reading mode, and the length of pauses 
between sentences. 

 

Size 

 Click the Size button to increase the size of all text in the 
Text View of the document. You can cycle eight preset sizes 
through using this button. The smallest size is 10 points, while the 
largest size is 72 points. 

Tip:  To specify an exact point size for the text, choose Visual 

Settings from the Settings menu. Adjust the Text Size 
slider bar until you find the desired text size and then click 

OK. 
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Line Space 

 Click the Line Space button to increase the amount of 
space between all lines of text in the Text View of the document. 
You can cycle six preset line spacing settings through using this 
button. 

Tip:  To manually specify the amount of line spacing, choose 

Visual Settings from the Settings menu. Enter the amount 

of space you want between lines of text in the Extra 

Spacing Between Lines edit spin box and click OK. 

Word Space 

 Click the Word Space button to increase the amount of 
space between all words in the Text View of the document. You 
can cycle six preset word spacing settings through using this 
button. 

Tip:  To manually specify the amount of word spacing, choose 

Visual Settings from the Settings menu. Enter the amount 

of space you want between words in the Extra Spacing 

Between Words edit spin box and click OK. 

Margins 

 Click the Margins button to increase the amount of blank 
space between the left and right edges of the page and the 
document text. You can cycle six preset margin settings using this 
button. Changes to the document margins are only visible in Text 
View. 
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To manually specify margins or define different margins for the left 

and right side of the page, choose Visual Settings from the 

Settings menu. Enter the new left and right margins in the Side 

Margins area and click OK. 

Color 

 Click the Color button to cycle through preset 
combinations of text and background colors. These color 
combinations have been designed to make the page easier to 
read. 

The available color combinations are shown below: 

¶ Black text on a white background 

¶ Black text on a rose background 

¶ Black text on a beige background 

¶ Black text on a sky blue background 

¶ White text on a black background 

Tip: To create your own background and text color combination, 

choose Visual Settings from the Settings menu. Select a 
new text color and background color from the available 

choices and click OK. 

 Mask 

 Click the Mask button to cycle through the different 
masking options. Masking is a special tool that shades certain 
elements of the document in order to emphasize the current line, 
sentence, or paragraph. You can only use masking in the Text 
View of a document. 
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The four masking options are:  

¶ No masking - No masking is applied to the document. 

¶ Line masking - Shades all text except the line where the 
cursor is currently located. 

¶ Sentence masking - Shades all text except the sentence 
where the cursor is currently located. 

¶ Paragraph masking - Shades all text except the paragraph 
where the cursor is currently located. 

Tip:  To make the shaded background and text lighter or darker, 

choose Masking from the Settings menu.  

Note:  You can only change masking settings while in Read only 

mode. When in Edit mode, you can only see masked text 

when you press the Read button to read the document.  

Self-Pace 

 The Self-Pace button allows you to control the pacing of 
WYNN's speech when reading documents. After you click Self-
Pace, choose one of the following reading options:  

¶ Continuous - When you click the Read button, the spotlight 
moves to emphasize the text WYNN speaks. WYNN 
continues reading the document until you click the Pause 
button. 

¶ By Line - When you click the Read button, WYNN reads the 
line of text emphasized by the spotlight and then stops. Click 
the Read button again to read the next line.  

¶ By Sentence - When you click the Read button, WYNN 
reads the sentence emphasized by the spotlight and then 
stops. Click the Read button again to read the next 
sentence.  
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¶ By Paragraph - When you click the Read button, WYNN 
reads the paragraph emphasized by the spotlight and then 
stops. Click the Read button again to read the next 
paragraph. 

Tip:  To manually adjust your reading preferences, choose 

General Settings from the Settings menu. 

 Click the Rate button to increase number of words per 
minute (WPM) WYNN speaks when reading text. There are five 
preset speech rate settings that you can cycle through using this 
button: 130, 160, 190, 220, and 250 WPM. 

Tip:  To manually change the speech rate, choose Speech 

Settings from the Settings menu. Use the Rate slider to 
determine how many words per minute WYNN speaks. 

 WYNN pauses slightly after each sentence just as a 
natural speaker would. You can use the Pause button to increase 
the length of this pause. There are four settings that you can cycle 
through using this button, allowing you to set the amount of pause 
from 0 to 1.5 seconds. 

Tip:  To manually specify the length WYNN should pause 

between sentences, choose Speech Settings from the 

Settings menu and make a new selection in the Extra 

Pause After Each Sentence combo box. 

Study Tools Toolbar 

The pink buttons on this toolbar allow you to access the basic and 
standard talking dictionaries, spell words audibly, divide words into 
syllables, highlight text, add bookmarks, view a list of highlighted 
or bookmarked words, and create text and voice notes. 
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Dictionary 

 WYNN includes a talking dictionary that lets you look up 
definitions and synonyms for words in your document. Click a 

word and then click the Dictionary button to view the word's 

dictionary entry. When you click Dictionary, you can choose to 
look up the word using the Standard dictionary or the Basic 
dictionary. The Standard dictionary is 7th-8th grade level while the 
Basic dictionary is 5th grade level. 

When you finish working with the dictionary, click Close to return 
to your document.  

Spell 

 WYNN can spell words that may be difficult to read.  

To spell a word out loud: 

¶ Click the word and then click the Spell button. 
 
WYNN displays the word and its spelling. WYNN then reads 
the word, reads and highlights each letter, and reads the 
word again.  

To read and spell the word again: 

¶ Click Repeat.  

To return to your document: 
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¶ Click Close. 
 

This button is not available if you have cleared the Text 

check box in the Speak What? area of the Speech Settings 
dialog box. 

Syllables 

 You can use WYNN to divide words into individual 
syllables and display the word's phonetic spelling. To see the 
syllables and the phonetic spelling of a word, click the word and 

then click the Syllables button. You can click Read Word to if you 

want WYNN to speak the word aloud. Click Read Syllables to 

have WYNN read each individual syllable separately. Click Close 
when you are finished to return to your document. 

Highlight 

 WYNN allows you to indicate important passages or key 
words in your document just as you would highlight text in a book. 

To highlight text in your document:  

¶ Click the Highlight button and choose a highlight color from 
the list. Your mouse pointer changes into a highlighter pen.  

¶ Click and drag the highlighter pen over text you want to 
highlight. WYNN highlights the text using the color you 
selected. You can highlight a single word by clicking it. 

¶ Click the Highlight button again when you are done 
highlighting text to return to a normal cursor.  
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To erase highlighting, click the Highlight button and then select 
the eraser at the bottom of the list. Your mouse pointer changes 
into a pencil eraser. Click and drag the eraser over the highlighting 
you want to remove. You can erase the highlighting for an 
individual word by clicking the word. 

Tip:  You can search for highlighted text using the Find toolbar 

button, or create a list of highlighted text with the Lists 
toolbar button. To print out just the text you highlighted in 

the document, click the Print button and select the 

Highlight Text Only radio button. 

Lists 

 WYNN allows you to create a new document containing 
text you have highlighted or bookmarked. You can use this feature 
to make lists of topic sentences, vocabulary words, useful facts, 
and more. 

To create a list, click the Lists button and choose the type of list 
you want to create and how you want to sort it: 

¶ By Highlight Color - Creates a list of all highlighted words or 
phrases. Text highlighted in green appears first in the list, 
text highlighted blue appears second, and text highlighted in 
magenta appears last. This choice is useful for categorizing 
information. 

¶ By Highlight Order - Creates a list of all highlighted words or 
phrases in the order they appear in the original document. 
This choice is useful for creating study guides with key 
points and supporting points. 

¶ By Bookmark Type - Creates a list of all bookmarked words 
or phrases from the original document. WYNN sorts the text 
into groups separated by bookmark type. 
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¶ By Bookmark Order - Creates a list of all bookmarked words 
or phrases arranged in the order they appear in the original 
document 

After selecting, WYNN creates a new document containing the 
highlighted or bookmarked text. If you have more than the 
maximum number of documents open, WYNN asks you to save 
your changes to the document you have accessed the least 
recently and then closes it. 

Bookmark 

 WYNN lets you bookmark important passages of text in a 
document for quick reference. When you choose a bookmark, a 
beginning and ending bookmark will appear around the word 
where the cursor is located. To bookmark a phrase, first select the 
text you wish to bookmark, and then choose your bookmark from 
the Bookmark button.   

To erase a bookmark, click the Bookmark button and select the 
eraser at the bottom of the list. Your mouse pointer changes into a 
pencil eraser. Click and drag the eraser over the bookmarked text. 

Tip:  You can search for bookmarks using the Find toolbar 

button, or create a list of bookmarked text with the Lists 
toolbar button. 
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Text Note 

 WYNN allows you to add notes to any location in your 
document. Teachers can create notes containing messages, 
questions, or assignments for students. Students can use notes to 
answer the teacher's questions, create reminders, or ask 
questions about the text. An icon appears where the note is 
located. To read the note, double-click the icon. To erase a note, 
put the cursor to the right of the Note icon and press the 
Backspace key on your keyboard. 

Tip:  You can search for notes in the document by using the 

Find toolbar button. When you print your document, all 
your notes are printed on a separate page with the heading 
Text Notes. To print just the notes contained in your 

document, click the Print button and select the Text Notes 

Only radio button. 

Voice Notes 

 Voice Notes are useful for those with stronger auditory 
than visual processing skills. This feature allows you to use the 
microphone to record a spoken message. Teachers can create 
Voice Notes containing questions, messages, or assignments for 
students. Students can use Voice Notes to record answers to the 
teacher's questions, create reminders, summarize or paraphrase, 
or ask questions about the text. An icon appears where the Voice 
Note is located. To listen to the note, double-click the icon. To 
erase a note, put the cursor to the right of the Note icon and press 
the Backspace key on your keyboard. 

Tip:  You can search for Voice Notes in the document by using 

the Find toolbar button.  
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Writing Tools Toolbar 

Use the yellow buttons on this toolbar to cut and paste text, apply 
bold, italic, and underline to text, find text in the document, create 
and work with an outline, enable/disable Word Prediction, check 
for homophones, and check your spelling. 

 

Cut/Paste 

 The Cut/Paste button allows you to cut, copy, and paste 
text. You must enter Write mode using the Write toolbar button 
before you can cut or paste text. 

Tip:  You can also press CTRL+C to copy, CTRL+X to cut, and 

CTRL+V to paste, or you can choose these options from 

the Edit menu. 

Tip:  You can paste text from WYNN into other applications, 
such as Microsoft Word. You can also paste text from other 
applications into WYNN. Use the copy, cut, and paste 
commands in the other applications just as you would use 
them in WYNN. These commands usually appear on the 

application's Edit menu. 

Style 

 The Style button allows you to apply bold, italics, or 
underline to text in your document. While in Write mode, click to 
place your insertion point within a word or select a range of text. 
Click the Style button and choose Bold, Italic, or Underline. WYNN 
then applies the formatting to the word or selected text.  
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Tip:  Standard Windows commands will also work for these 

functions: CTRL+B to choose Bold, CTRL+I to add italics, 

and CTRL+U to underline text. 

Find 

 Use the Find button to search for and replace text in the 
active document. If you search for text, you can replace it with new 
text, if necessary.  

To find any type of markup, such as highlights, voice notes, and 
text notes, use the Go To button to quickly open the Go To What 
dialog box.  

Go To 

 Click the Go To button to move to a specific page in your 
document. When you click Go To, a dialog box displays. Enter the 
page number of the page you want move to and click the Go 
button. If you only want to move forward or back one page in the 
document, use the Next Page and Previous Page buttons. 

Tip:  You can also press CTRL+G or choose Go To Page from 
the Edit menu to perform this command. 

Outlines 

 Outlines can help you organize the topics and supporting 
points of your documents. You can use outlines to plan the 
organization of research papers, summarize study materials, 
create plots for stories, and more. 
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Adjust 

 Use the Adjust button to make adjustments to an outline 
you created using the Outlines toolbar button. This button is only 
available when you are creating an outline. Move your cursor to a 
line in your outline and click the Adjust button. After you click 
Adjust, choose one of the following options: 

¶ Move Backward - Increases the outline level of the line and 
all its sub-items.  

¶ Move Forward - Decreases the outline level of the line and 
all its sub-items.  

¶ Move Up - Moves the line and all its sub-items up by one-
step within the current outline level.  

¶ Move Down - Moves the line and all its sub-items down by 
one-step within the current outline level.  

Refer to Organizing Ideas with Outlines on page 188 for more 
information about outline levels and creating outlines in WYNN.  

Tip:  You can also use the following shortcut keys to adjust the 

outline: move forward (TAB), move backward 

(SHIFT+TAB), move up (ALT+UP ARROW), and move 

down (ALT+ DOWN ARROW). 

Predict 

    Click the Predict button to activate WYNN's Word 
Prediction feature. Word prediction helps you write by making 
spelling suggestions and anticipating the next word you are going 
to type. This feature can help you with spelling, grammar, and 
formulating sentences. 
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Word Prediction 

 When Word Prediction is active, click the Speak List 
button to have WYNN read the list of suggested words. This 
button is unavailable if you are not using Word Prediction. For 
more information on the Word Prediction feature, refer to page 
190. 

Homophone 

 A homophone is two or more words that are pronounced 
alike, but have different meanings and often-different spellings. 

Spell Check 

 Click the Spell Check button to check your document for 
spelling errors. If WYNN finds any misspelled words, a dialog box 
appears that allows you to correct the mistake.  

Tip:  F7 also starts the Spell Check process. 

Web Toolbar 

The Web toolbar only displays when you are browsing the Web in 

WYNN. To display the Web toolbar, click the Go To Web button 
on the File Management toolbar. The following describes each 
button on this toolbar.  
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Back 

 Click the Back button to return to pages you have 
previously visited during the current session. 

Forward 

 Click the Forward button to move forward through pages 
you have already visited during the current session. You can only 
use this button if you have already clicked the Back button. 

Stop 

 Click the Stop button to stop the current page from 
loading completely. This button is useful if a particular Web page 
is taking a long time to load or if you accidentally open the wrong 
page. 

Refresh 

 Click the Refresh button to reload the current page. 
Some pages may need to be refreshed in order to display recent 
updates. Refreshing may also help correct errors if a page does 
not display properly. 

Home 

 Click the Home button to return to your home page.  



Getting to Know WYNN 

 

88   

Search 

 Click the Search button to search the Web for a particular 
subject or topic. Enter the topic you want to search for and then 
click the Search Now button. WYNN submits your search to 
Google.com and then displays the results on your screen. 

Favorites 

 Click Favorites to add a Web page to your list of 
favorites, organize your favorites, or visit pages in your favorites 
list.  

History 

 Click the History button to see a list of Web pages you 
have visited in the past. Choose the day you want to view history 
for. All the Web sites that you visited are displayed in the left-side 
panel. Click a Web site to display a list of all pages on the Web 
site that you visited. Click a Web page name to open the page. 

WebMask 

 Click the WebMask button to enable or disable the 
WebMasking feature. WebMasking shades distracting images and 
reduces visual clutter so you can focus on a specific element of 
the Web page, such as a paragraph or link. You can focus on a 
page element by clicking near it.  
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Dictionary 

 Click a word and then click the Dictionary button to view 

the word's dictionary entry. When you click Dictionary, you can 
choose to look up the word using the Standard dictionary or the 
Basic dictionary. The Standard dictionary is 7th-8th grade level 
while the Basic dictionary is 5th grade level. 

The dictionary entry for the selected word displays. When you 

finish working with the dictionary, click Close to return to the Web 
page. 

Highlight 

 To highlight text in your document:  

¶ Click the Highlight button and choose a highlight color from 
the list. Your mouse pointer changes into a highlighter pen.  

¶ Click and drag the highlighter pen over text you want to 
highlight. WYNN highlights the text using the color you 
selected. You can highlight a single word by clicking it. 

¶ Click the Highlight button again when you are done 
highlighting text to return the cursor to normal.  

To erase highlighting, click the Highlight button and then select 
the eraser at the bottom of the list. Your mouse pointer changes 
into a pencil eraser. Click and drag the eraser over the highlighting 
you want to remove. You can erase the highlighting for an 
individual word by clicking the word. 
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Extract 

 WYNN allows you to create a new document containing 
text you have highlighted or selected on Web pages. You can use 
this feature to make lists of topic sentences, vocabulary words, 
useful facts, and more. 

To extract Web text, click the Extract button and choose how you 
want highlights ordered or what you want to extract: 

¶ By Highlight Color - Creates a list of all highlighted words or 
phrases. Text highlighted in green appears first in the list, 
text highlighted blue appears second, and text highlighted in 
magenta appears last. This choice is useful for categorizing 
information. 

¶ By Highlight Order - Creates a list of all highlighted words or 
phrases in the order they appear in the original document. 
This choice is useful for creating study guides with key 
points and supporting points. 

¶ All Text - Extracts all text on the Web page to a document. 
You can extract the text into a new document or append it to 
an existing document. 

¶ Selected Text ï Extracts selected text on the Web page to a 
document. You can extract the text into a new document or 
append it to an existing document. 

After selecting, WYNN creates a new document containing the 
highlighted or bookmarked text. If you have more than the 
maximum number of documents open, WYNN asks you to save 
your changes to the document you have accessed the least 
recently and then closes it. 
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File List 

 Click the File List button to open the left-hand navigation 
panel. You can then switch between your open documents.  

You can also use the Window menu to switch between open 
documents. Either select the document you want to switch to from 

the menu or choose Next Document. See page 37 for the location 
of user files. 

Close Page 

 Click the Close Page button when you are finished 
browsing the Web. WYNN closes the current Web page and 
displays the last document you were working on. 

 WYNN Menu Bars 

The menu bar allows you to access every function and command 
in WYNN. The menu bar contains ten menus. The following table 
describes each menu.  

Tip:  If you wish to have the items on the menus speak, go to 

the Settings menu, then Speech Settings. From the 

Speak What option, check Menus and Dialogs.   

File 

The File menu allows you to manage files, print documents, view 
document properties, and more. 
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Edit 

The Edit menu allows you to switch between read-only and edit 
modes, cut/copy/paste and select text, apply character formatting, 
find/replace text and mark-ups, create outlines, and work with 
page numbering and order. 

Acquire 

The Acquire menu allows you to quickly acquire documents by 
selecting preconfigured workflows.  

View 

Use the View menu to show or hide certain elements of the 
WYNN application. You can also use this menu to switch to and 
magnify the Exact View for acquired documents. 

Tools 

The Tools menu contains reading commands, study tools like a 
spell checker, dictionary/thesaurus, and homophone checker, and 
mark-up tools like highlighting and bookmarks.  

Launch 

Using the Launch menu, you can add and manage a list of 
applications (for example, Microsoft Word, Notepad, and so on) so 
that you can start these programs from within WYNN.  

Advanced 

The Advanced menu allows you to access a number of special 
commands and features like Teacher Lockout, the Pronunciation 
Dictionary, and Word Prediction controls. You can also use this 
menu to launch external applications and select a scanner.  



Getting to Know WYNN 

 

  93  

Settings 

The commands available in the Settings menu allow you to 
customize WYNN. You can change visual settings, speech 
preferences, Web settings, masking, word prediction, differential 
coloring, and more. You can also customize WYNN's toolbars.  

Web 

The Web menu provides access to commands you can use to 
browse the Internet. These commands are similar to those found 
in popular Internet browser software and include Web navigation, 
favorites, history, and a refresh command. 

Windows 

The Windows menu allows you to switch between documents 
currently open in WYNN. 

Help 

The Help menu lets you view WYNN's online help system. 
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Workflow Overview and Settings 

What are Workflows? 

A workflow is a group of pre-defined settings that control how 
images are acquired and processed. Workflows can acquire single 
or multiple pages, acquire simple or complex documents with 
tables and other formatting, or acquire pages manually or 
automatically. You can also create your own workflow to meet 
your needs.  

The settings for each workflow are divided into two groups: 
Acquire and Process. Acquisition settings control how the 
workflow acquires images and where the page is placed in the 
document. Process settings control how text is recognized and 
where the reading cursor is positioned. Refer to the sections below 
for details. 

Note:  To create, modify, or restore workflow settings, see the 
section beginning with Creating a Workflow on page 118.  

Workflow Settings 

Note:  Earlier versions of WYNN used Scanning Settings to set 
individual aspects of how WYNN scanned documents. The 
Workflow Settings replaces and enhances the capabilities 
of Scanning Settings. 

Choose Workflow Settings from the Settings menu to select a 
different workflow, change current workflow settings, or create a 
new workflow when acquiring pages and images. Below are 
descriptions of the workflow options and settings. To customize 
workflow settings, use the options available in the Acquire tab 
page (see page 101) and the Process tab page (see page 106). 
Workflow changes are persistent across WYNN sessions. You do 
not have to save the workflow (using the Save the Settings 
command) each time you make a change.  
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Workflow Name 

Select a workflow to use when acquiring pages or images using a 
scanner, the PEARL camera, the Freedom Import Printer, a PDF 
file, or an image file. Below are the standard workflows. All 
workflows acquire and process images in color except as noted. If 
you want to acquire or process using black and white or grayscale, 
you can modify the settings for a workflow. This will probably 
speed up the acquisition and processing. 
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¶ Acquire and Read: This workflow acquires and processes a 
single image. The new page is added to the end of the 
document and the cursor is moved to the top of the new 
page. This workflow is best for quickly reading short 
documents, such as letters and recipes, and is the active 
workflow when WYNN starts for the first time. You can 
change both acquisition and process settings for this 
workflow.  

¶ Acquire Image Only: This workflow acquires the image and 
saves it as an image file, without performing the recognition 
process. This workflow is useful if you want to create and 
save an image file to be used later as a graphic. Acquired 
images can be saved as JPEG (default), BMP, PCX, PCX 
Fax, PNG, TIF Fax, TIF B&W, TIF LZW, TIF RLE, or TIF 
Uncompressed files. Since there is no processing involved, 
you can only modify Acquisition settings for this workflow.  

¶ Freedom Import Printer: Use this workflow to recognize 
and open documents that WYNN cannot open directly. If a 
document can be opened in any application that supports 
printing, it can be opened in WYNN by printing it to the 
Freedom Import Printer. This is a specialty workflow. It 
cannot be set as your current workflow. Since there is no 
acquisition involved, you can only modify Process settings 
for this workflow.  

¶ Multipage Automatic: Use this workflow to automatically 
acquire multiple pages and append them to the document. 
When using the PEARL camera, the workflow can be 
configured to detect motion as you turn the page, and then 
acquire the image when movement under the camera stops. 
To use motion detection, make sure to set the Page 
Acquisition Delay timer to 0. You can change both 
acquisition and process settings for this workflow.  
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¶ Multipage Prompt for Pages: This workflow allows you to 
continue reading from your current location and acquire new 
pages that are appended to the end of the document. After 
each new page is acquired, WYNN displays a dialog box 
with the options described below. After selecting an action, 
the dialog box closes and you can continue reading where 
you left off in the document. You can change both 
acquisition and process settings for this workflow.  

¶ Acquire Another Page: Choose this button to have 
WYNN acquire the next page and append it to the 
document.  

¶ Turn Pages Over: After acquiring one side of each 
page in a double-sided document, choose this to 
acquire the opposite side of each page and have it 
inserted into the document in the correct page order 
during recognition. For instance, if you were acquiring 
three double-sided pages, WYNN would first acquire 
pages 1, 3, and 5, you would next select Turn Pages 
Over, and then WYNN would acquire pages 6, 4, and 
2 in that order. The pages would then be placed in the 
correct order during the OCR (processing) step. In 
order for pages to be sorted correctly in the document, 
make sure you always acquire the opposite side of the 
last page, even if it is blank. This option is not available 
if you have already activated it, or if you have enabled 
the Split Facing Pages setting for the current workflow. 

Note: This feature is most useful with scanners that 
have an automatic document feeder.  

¶ Finished Acquiring Images: Choose this button to 
stop image acquisition. To start another acquisition, 
click the Scan button, or use the Acquire menu 
commands.  

¶ Paperback Books: Automatically acquires multiple pages in 
grayscale, but with Split Facing Pages turned on.  
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¶ PDF File: This workflow is used by default when you open a 
PDF file from within WYNN. It is a specialty workflow, which 
means that you can only modify process settings. It cannot 
be set as your current workflow. If WYNN is unable to 
process the particular file, you are prompted to use the 
Freedom Import Printer instead. If you choose Yes, WYNN 
switches to the Freedom Import Printer specialty workflow 
and resumes processing. Selecting No cancels the 
recognition, and the PDF file is not opened.  

¶ Process Image File: This is a specialty workflow that is 
used by default when you open an image file (TIFF, JPEG, 
and so on) from within WYNN. Use it to configure how 
WYNN processes image files. It cannot be set as your 
current workflow.  

¶ Worksheets - Color: Acquires a single page in color and 
appends it to the document.  

¶ Worksheets - Black & White: Acquires a single page in 
grayscale and appends it to the document.  

Set as Current  

Choose this button to make the selected workflow the active 
workflow. When you start an acquisition, WYNN uses the settings 
for the active workflow to acquire and recognize the page. This 
button is not available if the workflow in the list is a specialty 
workflow or is already set as the active workflow. 

Modify  

Choose this button to open a dialog box where you can change 
the Acquire and Process settings for the selected workflow. 
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Create New  

Choose this button to open the Acquire and Process wizard that 
guides you through creating a new workflow based on the settings 
of the currently selected workflow in the list. This button is not 
available for specialty workflows. 

Rename  

Choose this button to rename the selected workflow. You can only 
rename workflows that you create. This button is not available if 
the workflow selected in the list is a factory or specialty workflow.  

Remove  

Choose this button to delete the selected workflow. This button is 
not available if the workflow selected in the list is a factory or 
specialty workflow, or if the custom workflow you want to delete is 
still set as the active workflow. 

Restore Factory Values  

Choose this button to reset the selected workflow to its default 
settings. This button is only available if the selected workflow is 
labeled as "Modified" following the workflow name. 
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Recognition Defaults Group 

Use the items in this group to specify the languages that WYNN 
uses during the recognition process. (Note that this does not refer 
to the languages spoken by WYNN; rather it refers to the 
characters that WYNN identifies during the recognition process.) 
This is useful if the document you are acquiring has text that 
contains accent marks, umlauts, or other characters unique to a 
particular language. The recognition languages selected for 
Language 1 and Language 2 apply to all workflows. However, you 
can always configure different languages for a particular workflow 
using the Recognition Group settings (page 110) in the Process 
tab page.  

Language 1 

Use this item to specify the language used to read and decipher 
text. Select the language that corresponds to the language of the 
printed page you are acquiring. This allows correct recognition of 
characters unique to that language. 

Language 2 

Use this item to specify a second recognition language used to 
recognize acquired text. WYNN uses the languages selected for 
both Language 1 and Language 2 to recognize text. This is helpful 
if the document contains text from more than one language.   

Acquire Tab  

The settings on the Acquire tab page control how the workflow 
acquires images and where the page is placed in the document. 
These options are described below. 
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Acquisition Mode 

Use this box to specify whether WYNN acquires a single page or 
multiple pages. 

¶ Single: WYNN acquires one page from the scanner or 
camera, processes it, and begins reading. To acquire 
another page, you will need to press the acquire keystroke 
again. Single page acquisition mode is the default setting for 
all workflows except Paperback Books, Multipage Prompt for 
Pages, and Multipage Automatic.  

¶ Multiple: Lets you acquire a batch of pages for later 
processing. Some additional options become available when 
this mode is selected.  
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Image Properties Group 

Color Mode 

Select the color mode you want to use when acquiring pages. 
Color is the default acquisition setting for all workflows. Some 
workflows use black and white or grayscale for processing the 
image, but they all use color to acquire the image. 

¶ Color: Acquires and recognizes pages of colored text, art, 
and photographs in color. The results of color scanning are 
only apparent while you are in Exact View. For this reason 
you must have Keep Exact View As (page 107) set to color 
in the workflow you want to use for acquiring pages in color.  

¶ Gray Scale: Select this item if it is not necessary to have the 
Exact View image in color.  

Resolution 

Resolution is measured in dots per inch (dpi). The higher the 
resolution, the more dots per inch resulting in larger image files. 
The Resolution box allows you to select from 200, 300, 400, 500, 
or 600 dpi. The resolution is set to 300 dpi for all workflows. 

Many scanners have a standard setting of 300 dots per inch (dpi). 
However, if you are reading pages printed in very small type and 
have a scanner that can resolve as finely as 400 dpi, you may see 
improved recognition accuracy. For 400 dpi to be effective, your 
scanner must have an optical resolution of at least 400 by 400 dpi. 
An optical resolution of 300 by 600 dpi is not adequate.  

Note:  This setting is ignored if the acquisition source is the 
PEARL camera. 
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Acquisition Size Group 

Full Device Length 

When this check box is selected, WYNN acquires the full length of 
the scanner bed, or the entire field of view under the PEARL 
camera (9 inches by 12 inches (22.86 cm by 30.48 cm)). If you 
clear this option, you can then specify how much of the scanner 
bed is scanned or how much of the area under the camera is 
captured. This item is selected by default in all factory workflows.  

Partial Acquisition 

Available only when the Full Device Length check box is cleared, 
this slider control allows you to specify how much of the scanner 
bed, or how much of the area under the PEARL camera, is 
acquired starting from the top. You can set it any where between 
10 and 90 percent. Partial Acquisition is a useful way to preview 
your acquisition since WYNN acquires just enough of the page for 
you to get an idea of the content.  

Adjust Image Group 

If you are using a scanner to acquire images, these options control 
the light-to-dark contrast ratio in the acquired document. 

Note: This item is equivalent to the Scanning Contrast setting in 
earlier versions of WYNN. 

Automatic Contrast / Contrast Slider 

Select this check box to have WYNN automatically adjust the 
contrast accordingly depending on the type of page being 
acquired. If this option is unchecked, you can then use the 
contrast slider to manually adjust the contrast from darkest to 
lightest. You should only manually change the contrast if a 
particular page is not being recognized correctly on automatic 
contrast. 
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Note:  If the acquisition source is the PEARL camera, the contrast 
settings are ignored. 

Progress Notifications Group 

Acquisition Tones 

Select this check box to hear tones during the acquisition process. 
The default for the item is unchecked. 

Image Acquired 

Select this check box to hear a camera shutter sound when an 
image is acquired from the scanner or camera. The default for this 
item is checked. 

Page Placement 

Select one of the following options to specify where to place the 
acquired page in the document. 

¶ Append to Document: New page(s) are placed at the end 
of the document.  

¶ Insert After Current Page: New page(s) are inserted 
consecutively after the current page.  

¶ Insert Before Current Page: New page(s) are inserted 
before the current page.  

¶ Replace Current Page: The current page is replaced with 
the newly acquired page.  

Multipage Acquisition Group 

The options in this group are available when Acquisition Mode is 
set to Multiple. Use these options to specify how to acquire 
multiple pages.  
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¶ Prompt for Pages: After each image acquisition, a message 
displays that allows you to acquire another page, turn the 
page over to acquire odd and even pages, or finish image 
acquisition.  

¶ Automatically Acquire Pages: Select to acquire new pages 
after a certain period of time, automatically through a 
document feeder attached to a scanner, or as soon as 
PEARL detects the page has been turned and there is no 
movement under the camera. When using automatic 

acquisition, use the Page Acquisition Delay box to set a 
time delay from 0 to 25 seconds. This delay is from the time 
the image is acquired until the next acquisition begins.  

¶ Duplex Mode: If your scanner has a duplexer, select this 
check box to use this feature.  

Process Tab 

Use the Process tab settings to control how text is recognized and 
where the reading cursor is positioned. These options are 
described below. 
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Image Processing Group 

Keep Exact View As 

The Exact View image can be saved as color, grayscale, or black 
and white. To change the color mode of the Exact View, select a 
mode from the list.  

Note:  If the color setting for Acquire is set to Grayscale, the page 
you scan will not have any color. Even if you set Keep 
Exact View As color, the image will still be displayed in 
Exact View in grayscale. 
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Despeckle 

Select this check box to correct pages that do not have a clean, 
clear background, such as photocopies or newspapers. 

Text Processing Group 

Discard Blank Pages 

Select this check box to delete blank pages after you scan them. 
Clear this check box to retain the original page numbering and 
order. This item is unchecked by default, so WYNN will keep blank 
pages. 

Apply OCR Corrections 

Select this check box to apply OCR corrections to documents as 
they are scanned. The OCR Correction feature lists misidentified 
words and their appropriate replacements. You can add, delete, or 
change words in this list. This item is selected by default. 

Keep Text Emphasis 

Select this check box to keep attributes such as bold and italics 
during OCR. This item is selected by default. 

Replace Uncertain Text / Uncertain Text Marker 

Select this check box to insert a special character, or marker, next 
to text that WYNN is having difficulty recognizing. Enter the special 
character you want to use to mark uncertain text in the Uncertain 
Text Marker edit box. This item is cleared by default. 
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Preserve Line Breaks 

Select this check box to keep line breaks during recognition. Use 
this option if you are acquiring a document where retaining the line 
breaks where they actually appear in the original text can improve 
the flow when reading. This item is cleared by default. 

Page Layout Group 

Recognize Columns / Ignore Columns 

¶ Recognize Columns: When selected, the OCR process 
analyzes the text and automatically detects columns if they 
are present. Each column is handled in order, from top to 
bottom, left to right, before handling the next column. This 
setting does not preserve the columnized layout in WYNN, 
but it does ensure that correct reading order is observed for 
columnized text. This is the default setting for all workflows.  

¶ Ignore Columns: When selected, it causes the OCR 
process to disregard column boundaries that may exist. This 
means that each line of text is recognized from left to right, 
all the way across the page, potentially spanning multiple 
columns. This method does preserve columnized layout, but 
creates incorrect reading order for the reader.  

Split Facing Pages 

Select this check box to scan two side-by-side pages of a 
paperback book in a single scan. Each page is stored separately, 
with separate page numbers. This helps maintain the original page 
numbering. Clear this check box when scanning individual pages. 

Table Processing Group 

The options in this group configure how documents containing 
tables, such as financial or statistical information, is processed. 
Tables can be organized either by row or column. 
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¶ Select Organize by Row to lay out the table text as rows 
with space between the column items. This is the default 
setting for all workflows.  

¶ Select Organize by Column to lay out the table text as 
columns with space between the row items.  

Action When Pages are Recognized 

The options in this group control where the reading cursor is 
positioned after a new page is recognized. 

¶ Select Move to New Page to move the cursor to the top of 
the newly recognized page.  

¶ Select Remain at Current Reading Position to keep the 
cursor at its current position in the document even after the 
new page is added.  

Start Speaking Automatically 

Select this check box so that WYNN automatically begins reading 
from the top of the newly acquired page as soon as it is 
recognized and the text becomes available. If the check box is 
cleared, use the Read button to read the text. This item is 
unchecked by default for all workflows. 

Recognition Group 

Use Default Recognition  

Clear this check box if you want to use different languages for text 
recognition for only this workflow.  When cleared, the Language 1 
and Language 2 boxes are available for you to select languages. 

Select this check box if you want to continue using the recognition 
languages that apply to all workflows. (See Recognition Defaults 
Group on page 101.) 
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Teacher Exercise Guide 

This section describes tasks that teachers can use to configure 
WYNN for overall operation. It also provides exercises that 
teachers can create or demonstrate for students.  

Note: For acquisition basics, see Acquiring a Document into 
WYNN on page 41. For information about acquisition 
settings, see Workflow Overview and Settings on page 95.   

Acquiring/Scanning with WYNN 

This section describes how to manually and automatically acquire 
(scan) multiple pages in documents. For detailed information, see 
Acquiring a Document into WYNN on page 41.  

Before You Acquire or Scan 

Before you scan (or acquire) a document, make sure that: 

¶ You are using WYNN Wizard. WYNN Reader does not have 
scanning capability. 

¶ The scanner is turned on and connected to your computer, 
or the PEARL camera is connected.   

¶ The drivers for your scanner are installed on your computer. 

¶ WYNN is running. 

¶ The blue File Management toolbar is displayed. 
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Important:  

Always use the blue Scan button ï  ï when scanning 

with WYNN. The Scan button is in the blue File 

Management toolbar. If there is a Scan button located on 

your scanner, do not use this button to acquire documents 
into WYNN, even if instructed to do so in your scannerôs 
manual.   

 If your scanner has a Scan button, never use it when 
scanning with WYNN. 
 

You can also press F3 to start acquiring pages and ESC 
again to stop. 

Note:  Some scanners use the back of the scanner glass for page 
placement for the top of the page. Others use the front of 
the scanner glass. Each scanner has an arrow or some 
other mark to show you where the top of the page should 
be; make sure you are familiar with your scannerôs 
orientation. 

Note: In WYNN 5.10 or earlier, you would scan documents using 

the Scan menu and the Scanning Settings dialog box. In 
WYNN 6.0 or later, scanning is now referred to as 
acquiring since you can now use a scanner or PEARL 

camera to acquire documents or images. The Scan menu 

is now called the Acquire menu, and the Scanner 

Settings dialog box is now the Workflow Settings dialog 
box.  
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Acquiring Multiple Pages 

There are three parts to the acquisition process: (1) acquiring the 
page image, (2) processing the image, and (3) recognizing the 
image or converting it to electronic text. WYNN normally acquires 
a page, then immediately processes and recognizes it before 
moving on to the next page. When acquiring a document with 
multiple pages, the Multipage workflows allow you to separate 
these processes; all the scanning is done at one time, followed by 
the processing and recognition of the pages, which can be done at 
a later time if needed. The WYNN program can acquire multiple 
pages using the following workflows: 

¶ Multipage Automatic  

¶ Multipage ï Prompt for Pages, see page 115 

¶ Paperback Books, see page 116 

Multipage Automatic Workflow 

Use this workflow to automatically acquire multiple pages and 
append them to the document. When using the PEARL camera, 
the workflow can be configured to detect motion as you turn the 
page, and then acquire the image when movement under the 
camera stops. To use motion detection, make sure to set the Page 
Acquisition Delay timer to 0. (See the procedure below for the 
location of this option.) You can change both acquisition and 
process settings for this workflow.  

To acquire multiple pages automatically,  

1. From the Settings menu, select Workflow Settings, and 

then Multipage-Automatic in the Name list. 
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2. Click OK.  

WYNN is now configured for Multipage-Automatic mode.  

To change the Page Acquisition Delay timer for use with the 
PEARL camera,  

1. Click the Modify button in the Workflow Settings. 

2. Select the Acquire tab, and then the Page Acquisition 

Delay option. 
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Multipage ï Prompt for Pages Workflow 

Use the Multipage ï Prompt for Pages workflow if you need to 
acquire multiple pages that are spread through different sections 
of a book. This allows you take your time to locate and then 
acquire different pages. After each new page is acquired, WYNN 
displays a dialog box that allows you to continue scanning pages 
or stop the acquisition process.  

To use this workflow, do the following. 

1. From the Acquire menu, choose Workflow, and then 

Multipage ï Prompt for Pages.  

2. Click the Scan button.  
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3. In the Multipage Image Acquisition dialog box, choose 
one of the following: 

¶ Acquire Another Page. Use it to acquire the next 
page and add it to the end of the acquired image  

¶ Turn Pages Over. Use it to acquire one side of a 
double-sided document, which allows you to first 
acquire odd pages (for example, 1, 3, and 5), and then 
acquire even pages (for example, 6, 4, and 2) in this 
order. This method is ideal when using a scanner with 
an automatic document feeder, or the PEARL camera. 
When using PEARL, you will center the odd pages 
under the camera, and then center the even pages 
under the camera. During OCR processing, the pages 
are placed in the correct order.  

¶ Finished Acquiring Images. Use it to stop image 

acquisition. To start another acquisition, click the Scan 
button again.  

4. This process is repeated until you stop the scan. When 
finished, the acquired pages now display in the open 
document.  

Paperback Books ï Acquiring Small Documents 

The Paperback Book workflow is intended for physically smaller 
documents, such as paperback books, in which both pages of the 
open book fit on the scanner or under the PEARL camera at the 
same time. When used, the scanner or camera sees these as one 
page, but WYNN processes them as two separate pages.   

When acquiring a small document, you must first select the 
Paperback Book workflow, next align the document on the 
scanner or under the PEARL camera, and then start the 
acquisition (scan).  
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1. From the Acquire menu, click Workflow and select 

Paperback Books.  

A checkmark appears next to Paperback Books, which 
now becomes the current workflow.  

2. Place the book sideways and face-down on the scanner, 
or face-up under the PEARL camera. For PEARL, make 
sure that one edge of the book is against the page guide, 
and then center the book between the outer edges of the 
page guide. This allows you to capture two pages at once 
and maintain pagination.  

Note: For smaller documents (a business card or postcard), 
place a blank white sheet of paper under the PEARL 
camera, and then the document on the blank page. 

3. After aligning the book, move your hands out of the way, 

and press the Scan button to acquire an image and start 
reading. 

Note: If it is necessary to hold the book flat, make sure that your 
fingertips are on the very edge of the page so that they do 
not obscure any text in the acquired image. 

Acquiring Difficult Text 

When scanning difficult text, such as very small text, unusual 
fonts, or unusual layouts, use the workflow best suited for the type 
of work you are doing, and then use that is best for the task at 
hand, and then use Dynamic Zoning to make the appropriate 
changes to the document. See page 123 for Dynamic Zoning 
procedures.  
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Creating a Workflow  

While you may be satisfied using the pre-configured workflows, 
you can create your own custom workflows to achieve the best 
results possible when processing the material you need to access. 
You can create as many workflows as you want using any 
combination of settings. For example, you may like the settings in 
the Acquire and Read workflow, but you need to recognize text in 
another language. Or, when acquiring a book, you may want to 
change the delay for automatic page acquisition, keep any blank 
pages, or turn off column recognition.  

To create a new workflow, do the following:  

1. Click the Settings menu and then Workflow Settings.  

2. Select any workflow from the Name list box (this will serve 
as the base for your custom workflow), and then click the 

Create New button. (This button is not available for 
specialty workflows like the Freedom Import Printer, PDF 
File, or Process Image File.) 

3. The Create New Workflow wizard opens on the Acquire 
page, which contains the settings that determine how the 
workflow acquires images from the scanner or PEARL 
camera. By default, this page uses the settings from the 
currently selected workflow.  

Make changes to the Acquire settings, and, when 

finished, choose Next to go to the Process page. See 
Acquire Tab on page 101 for information about the 
Acquire settings.  
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4. On the Process page, configure the settings this workflow 
will use when recognizing text and where the reading 
cursor is positioned after the new page is added to the 
document. As with the Acquire page, this page uses the 
settings from the currently selected workflow. See 
Process Tab on page 106 for information about the 
Process settings. 

5. Click Finish and the Workflow Name dialog box opens. 

Type a name for your new workflow then click OK. The 
new workflow now appears in the list of workflows.  

6. If you are done, click OK to close the Workflow Settings 
properties page.  

Setting the Active Workflow  

Whenever you begin a new image acquisition, WYNN uses the 
settings from the currently active workflow to acquire the image 
and recognize the text. You can use the procedure below to set 
the active workflow.  

To set the active workflow,  

1. Click the Settings menu and then Workflow Settings.  

Note:  In the Name list box, the workflow that is currently active is 
highlighted and also has the word ñcurrentò listed after its 
name.  

2. Select a workflow from the Name list box.  

3. Click the Set as Current button to make this workflow the 
active workflow each time WYNN starts. 

Note: This button is not available if the workflow selected in the 
list is a specialty workflow, or is already set as the active 
workflow.  
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4. Click OK to close the Workflow Settings properties page. 
The next time you acquire an image, the settings for the 
workflow are used.  

Modifying a Workflow  

To change the settings for a factory, specialty, or custom workflow, 
do the following:  

1. Click the Settings menu and then Workflow Settings.  

2. From the list of workflows, select the workflow whose 

settings you want to modify, then click Modify.  

Note:  In the Name list box, the workflow that is currently active is 
highlighted and also has the word ñcurrentò listed after its 
name.  

3. Once the Workflow dialog box opens, make any desired 
changes to settings in Acquire and Process pages, and 

then click OK to close the dialog box.  

4. In the Name list box in the Workflow Settings page,  

¶ If you made changes to the currently active workflow, 
the new settings will be used the next time you acquire 
an image.  

¶ If you modified a factory workflow, the word ñmodifiedò 
displays after the workflow name in the list. For 
example, ñAcquire and Read ï modified.ò A modified 
specialty workflow will display ñ(specialty) ï modifiedò 
after the workflow name, such as ñPDF File (specialty) 
ï modified.ò  
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Note:  If you choose to modify one of the specialty workflows, you 
can only change acquisition settings for the Acquire from 
Word specialty workflow. For the Freedom Import Printer, 
Image File, and PDF File specialty workflows, only the 
Process page is available.  

5. Click OK to save workflow changes. Note that if you 
modify a workflow and want to use it right away, you must 

also set it to be your current workflow by selecting the Set 

as Current button in the Workflow Settings. 

Renaming a Custom Workflow  

If you would like to rename a custom workflow you created, do the 
following:  

1. Click the Settings menu and then Workflow Settings.  

2. From the list of workflows, select the workflow you want to 

rename, and then click the Rename button. This button is 
not available if the workflow selected in the list is a factory 
or specialty workflow.  

Note:  In the Name list box, the workflow that is currently active is 
highlighted and also has the word ñcurrentò listed after its 
name.  

3. When the Workflow Name dialog box opens, type a new 

name for the Workflow and click OK.   

4. Click OK to close the Workflow Settings properties 
page.  

Deleting a Custom Workflow  

To delete a workflow you created, do the following:  

1. Click the Settings menu and then Workflow Settings.  
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From the list of workflows, select the workflow you want to 

delete, and then click the Remove button. This button is 
not available if the workflow selected in the list is a factory 
or specialty workflow, or if the custom workflow you want 
to delete is still set as the current workflow. If the custom 
workflow you want to delete is active, set a different 
workflow as the active workflow and you will then be able 
to delete the particular custom workflow.  

Note:  In the Name list box, the workflow that is currently active is 
highlighted and also has the word ñcurrentò listed after its 
name.  

2. A dialog box opens asking if you are sure you want to 

delete the workflow. Click OK if you are sure you want to 

delete the selected workflow. Otherwise, click Cancel.  

3. Click OK to close Workflow Settings.  

Resetting a Factory Workflow  

To restore a modified factory workflow to its default settings, do 
the following:  

1. Click the Settings menu and then Workflow Settings.  

2. From the list of workflows, select the workflow you want to 
reset, and then activate the Restore Factory Values 
button. This button is only available if the selected 
workflow has ñmodifiedò following the workflow name.  

3. Click Yes to confirm that you want to reset the workflow 
settings.  

4. Click OK to close the Workflow Settings.  
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Rearranging Text in an Acquired Document 

Dynamic Zoning allows you to define your own reading order on 
an acquired page. Dynamic Zoning can also be used to avoid 
recognition errors from graphics, or to exclude the speaking of 
headers, footers, or other unwanted text.   

Note:  Use the Dynamic Zoning feature before using the 
Document Clean-up feature (page 125). 

1. From the Advanced menu, click Dynamic Zoning, and 

then Enable Dynamic Zoning and Show Current 

Zones.   

The acquired image appears in Exact View mode with all 
current reading zones outlined in blue.  
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Take a moment to study the document and determine 
how you want to redefine reading zones.  

2. Select the Re-Define button to remove the current zone 
indicators so that you can redraw the zones in the correct 
order.  
 

  

3. Use your mouse to draw a box around each block of text 
you wish to have spoken. A red outline appears around 
redefined zones. 
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The reading order is determined by the order in which you 
define the zones. Do not draw zones around pictures or 
other graphic images that cannot be spoken. 

Note:  If you make a mistake while redefining zones, click the 

Revert button to return to the original zones on that page. 

You may also use Erase to erase all zones created and 
start over again.  

   

4. To continue changing zones on other pages of the 

acquired document, press the Page Down key until the 
next page appears. (The message ñLoading Pageò 
appears in the lower left corner.) Again, the existing 
zones appear in blue.  

5. Repeat step 2 and 3 to redefine the reading order for the 
next page. Repeat this process for each page you wish to 
re-zone. 

6. After defining new zones on all pages that apply, select 

the Re-Process button. This tells WYNN to refresh the 
document using the newly defined zoning order.  
 

 

Correcting Text in an Acquired Document  

Use the Document Clean-up feature to correct any scanning or 
recognition errors that occurred during document scanning. This 

feature displays both the Exact View and the Text View of the 
document so you can compare them. This allows you to easily 
correct errors so that the text is spoken correctly in either view.  

To correct the text of an acquired document: 
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1. From the Advanced menu, choose Document Clean-up.  

WYNN displays the Text View of the document in the top 

half of the window, and the Exact View of the document 
in the bottom half of the window.  

 

2. Scroll through the Text View, and look for OCR errors.  

3. Click an incorrect word you find in the Text View.  

WYNN moves your insertion point to the word. A pink 

rectangle appears around the word in the Text View 
window, while the same word appears as highlighted text 

in the Exact View window.  
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Note:  You can also click a word in the Exact View to place a pink 
rectangle around the location where the word appears in 
the Text View. 

4. Correct any spelling or scanning errors.   

Important:  
When correcting errors, do not delete the whole word. First, 
type in the corrections, and then delete the errors. Deleting 
the entire word prior to inserting corrections erases the link 
that WYNN uses to connect the word in the Text View and 
Exact View. In this case, WYNN no longer spotlights the 
word in Exact View when reading.  

5. Continue searching the Text View window for OCR 

errors. When you are finished, choose Document Clean-

up from the Advanced menu. 

6. Click the Save button from the blue File Management 
toolbar to save your corrections. 

Document Clean-up Guidelines 

Keep the following items in mind when using the Document 

Clean-up feature.  

1. Use Exact View to reference original text. 

2. Make corrections in Text View. 

3. Keep the link between Text View and Exact View by 
correcting parts of a word at a time until the entire word is 

corrected. If you delete an entire word in Text View, it 

breaks the link between Text View and Exact View. The 
location in Exact View is no longer spotlighted.  

4. After closing the Document Clean-up feature, run Spell 

Check, in Text View mode, to catch random characters 
or mistaken words. 
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Guidelines for Increased Scanning Accuracy 

¶ Use OCR Correction (Advanced menu) to catch repeated 
recognition errors. 

¶ Modify Scanning Contrast (Settings menu, Scanning 
Settings command) for light text or dark paper.  

¶ Use Dynamic Zoning to eliminate recognition of changes or 
graphics. 

Acquiring and Reading Other Languages in 
WYNN 

WYNN can acquire and read in several languages in addition to 
English. These languages are installed during the initial installation 
process.  

Acquiring Documents in a Language other than 
U.S. English 

When acquiring documents that are in different language, you can 
select a primary and secondary language to identify text and 
characters, such as accent marks and umlauts that are unique to 
a particular language. These languages only apply to the 
recognition process and not the language used for WYNN speech. 
The recognition language settings apply to all workflows unless 
specifically configured or a particular workflow.     

To select the default primary or secondary recognition language, 
do the following:  

1. Click the Settings menu and then Workflow Settings.  

2. Next, use the Language 1 and Language 2 options to 
select the primary and secondary recognition languages. 
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¶ In the Language 1 edit box, select the language that 
corresponds to the language of the printed page you 
are acquiring. This allows correct recognition of 
characters unique to that language. 

¶ In the Language 2 edit box, select a secondary 
language to use for recognizing the acquired text. Both 
Language 1 and Language 2 settings are used to 
recognize text.  

Note: These languages are not used by WYNN to speak; rather 
they are used to identify characters unique to that language 
during the recognition process. 

3. Click OK to apply your changes and close the dialog box.  

Reading Documents in a Language other than 
U.S. English 

To change speech language settings, refer to the Adjusting 
Speech section on page 57.    

Selecting the Correct Word Using 
Homophones 

Being able to identify which word to use in a sentence can build a 
studentôs vocabulary. The following task provides an overview for 
using the Homophones function for a student exercise.  

1. Create or provide a passage of text that contains 
homophones.  

You can do this by scanning text directly into WYNN, or 
by providing an external document (such as a Word, 
PDF, text, RTF, or HTML file) that WYNN can open.   
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2. Ask the student to open the document, and run the 
Homophones function using the Homophones button on 

the yellow Writing Tools toolbar.  
 

 

3. Make sure that the student reads each definition and 
selects the correct word as used in the sentence. 

Broadcasting Documents and Settings 

Broadcasting is a powerful function that allows teachers to 
broadcast WYNN files and settings to a classroom of users. You 
can log on to a single computer and download files and settings 
for just the user accounts on a specific computer, or, if using the 
network version of WYNN, you can broadcast files and settings to 
all users on the network, regardless of which computer they use to 
log in.  

Note:  To broadcast documents or settings, you must sign in to 
WYNN using the login name Shared. This name does not 
appear on the list of user names, so you must manually 
enter it each time. The Broadcast Documents and 
Broadcast Settings commands are not available unless you 
log in with the name Shared. 

Broadcasting Documents to Other Users 

You can send documents to other WYNN users. This allows you to 
copy documents located in the Docs folder for the login name 
Shared to the Docs folder that belongs to each user.  

To broadcast documents to other users, 
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1. If you are not already logged in as Shared, from the File 

menu, choose Log Off. (Note that this command is 
followed by the current userôs log in name.) 
 

 

2. Sign in using the login name Shared and click OK. 

 



Teacher Exercise Guide 

 

132   

3. From the Advanced menu, click Broadcast Documents.  

 

4. Select the document you want to broadcast. Hold down 

CTRL and click to select multiple documents. You can 
only broadcast documents stored in WYNN's 
Shared\Docs folder.  

Note:  You can only broadcast closed documents. If the document 
is open, you must close it first before you can broadcast it. 

 

5. Click Broadcast to send the documents to all other 
users. 



Teacher Exercise Guide 

 

  133  

Broadcasting Settings to Other Users 

WYNN allows you to send your abbreviation definitions, OCR 
corrections, personal spell check dictionary, pronunciation 
dictionary, word prediction lists, custom toolbars, and so on to all 
other users.  

To broadcast customized or modified settings to other users: 

1. If you are not already logged in as Shared, from the File 

menu, choose Log Off. (Note that this command is 
followed by the current userôs log in name.) 

 

2. Sign in using the login name Shared and click OK. 
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3. From the Advanced menu, click Broadcast Settings. 

 

4. Select the type of settings you want to broadcast. Hold 

down CTRL and click to select multiple types of settings. 
You can only broadcast settings associated with the user 
name Shared. 
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5. Click Broadcast to send the settings to all other users. 

Adding Words to the Pronunciation 
Dictionary 

The Pronunciation Dictionary allows you to define how WYNN 
pronounces words that it reads aloud. Speech synthesizers do a 
good job of pronouncing words through a combination of text-to-
speech programming and internal dictionaries. However, there 
may be some words that the synthesizer does not pronounce 
properly. These words vary from synthesizer to synthesizer. Using 
WYNN's Pronunciation Dictionary, you can change the 
pronunciation of any word. 

To add a new word, phrase, or acronym to the Wynn 
pronunciation dictionary: 

1. On the Advanced menu, click Pronunciation Dictionary. 

The Pronunciation Dictionary dialog appears.  
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2. Scroll through the Word List to make sure that the new 
text does not appear in the pronunciation dictionary.  

3. Type the new word into the Word edit box.  

4. Enter a pronunciation for the word in the Pronunciation 
edit box.  

Try spelling the word phonetically using simple 
combinations of consonants and vowels. Use spaces to 
separate letters if you want WYNN to say the name of the 
letter rather than make the associated sound (this is 
useful for acronyms). 

Tip:  You can also use spaces to isolate phonetic sounds 
created by two or more letters. The synthesizer clearly 
pronounces these sounds when reading the word. 

5. Click Test to hear the new pronunciation of the word. 
Continue adjusting the pronunciation until you achieve the 
desired pronunciation. 

6. When you are satisfied with the pronunciation, click the 

Add button to update the Pronunciation Dictionary.  
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7. Click Close to return to the active document. 

Configuring Word Prediction  

The Word Prediction feature is useful for people who have 
difficulty coming up with words or spelling while writing. It offers 
suggestions that complete the word the student is typing, and it 
proposes the next word for the student to type. This allows your 
students to focus on getting their ideas ñon paper,ò regardless of 
their ability to spell. 

 

Using the control tabs of WYNNôs Word Prediction Teacher 
Controls, you can:  

¶ Customize word and phrase suggestions provided by the 
Word Prediction feature 

¶ Increase or decrease the Word Predictionôs word list by 
adding words and phrases 

¶ Define phonetic spelling information  
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¶ Choose writing styles, and more 

Word Prediction Learning Text Tab 

Use the Word Prediction Learning Text tab to have the word 
prediction system learn new words from a file or the current 
document. You can also have WYNN learn words as you type. 

To analyze and learn vocabulary patterns from a plain text file or 
the current document: 

1. From the Advanced menu, choose Word Prediction 

Teacher Controls. 

2. Click the Word Predication Learning Text tab. 
 

 

3. Do one of the following: 

¶ If you want WYNN to learn from the current document, 

click the Current Document button, or  
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¶ If you want WYNN to learn vocabulary patterns from a 

plain text file, click the Text File button. Locate the file, 

select it, and click Open. 

4. WYNN adds new phrases from the current document or 
text file to the word prediction list. 

To analyze and learn vocabulary patterns as you type: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Predication Learning Text tab. 

3. Select the Automatically Learn as I Type check box. 

4. If you want WYNN to check the spelling of each word or 
phrase before adding it to the word prediction list, select 

the Spell Check Each Word Before Learning check 
box. 

5. Click OK.  

Word Prediction Edit List Tab 

As you type, new words and phrases are added to the word 
prediction list. 

The Word Prediction Edit List tab allows you to select a different 
size word list or add words to the list for the current user.  
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Tip:  You can search for words already in the word prediction 

list. To do this, enter the word and then click Search. 
WYNN displays a list of phrases containing the word. 

Adding Words/Phrases to the List 

To add a word or phrase to the word prediction list: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Edit List tab. 

3. Click the Add a Word button. 

4. Type the word you want to add to the word prediction list. 

5. Specify whether the word is a verb, noun, or other by 
selecting the corresponding radio button. 
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WYNN automatically displays some suggestions based 
on the spelling of the word and the word's part of speech.  

¶ For verbs, WYNN suggests how the word appears 
when used in the various tenses.  

¶ For nouns, WYNN suggests how the word is pluralized 
and how it is used in different situations.  

¶ For other words, WYNN wants you to enter several 
phrases where the word is used in context.  

Review the suggestions and correct any words that do 
not reflect proper usage. 

6. Click the OK button to add the word. 

Restoring the Default List  

To remove all changes made to your personal word prediction list 
and to restore the default list: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Edit List tab. 

3. Click the Clear All Personal Learned Text button. 

4. Click OK to restore the default word list.  

5. Click Cancel to keep your personalized word list. 
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Word Prediction Phonetics 

Use the Word Prediction Phonetics tab to add, modify, or delete 
phonetic associations. This feature allows you to customize Word 
Prediction so that it corrects commonly misspelled phonetic 
sounds. For example, phonetic associations allow WYNN to 

recognize f as a possible misspelling of the sound created by the 

letters ph. 

 

Adding Phonetic Associations 

To add a new phonetic association to the word prediction list: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Phonetics tab. 

3. In the Phonetic edit box, type the incorrect phonetic 
spelling of the sound. 

4. Type a comma. 
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5. Type the correct spelling of the sound.  

Example: To recognize f as a possible misspelling of the 
sound created by the letters ph, type "f,ph" in the 
Phonetic edit box. This creates a phonetic association 
between f and ph. 

6. Click the Add button. 

7. Click the OK button to save your changes. 

Modifying Phonetic Associations 

To modify an existing phonetic association: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Phonetics tab. 

3. Select the phonetic association you want to modify in the 

List of Phonetic Associations. 

4. In the Phonetic edit box, change the phonetic 
association. 

5. Click the Update button. 

6. Click the OK button to save your changes. 

Deleting Phonetic Associations 

To delete phonetic associations: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Phonetics tab. 
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3. Locate the phonetic association in the List of Phonetic 

Associations and select it.  

4. Click the Delete button. 

Tip:  If you do not want to delete a phonetic association, yet you 
do not want it to apply to the current document, clear the 
adjacent check box. You can restore the association at any 

time by selecting the check box again. Use the Clear All 

and Select All buttons to quickly select or clear all the 
check boxes. 

Word Prediction List 

The Word Prediction Lists tab allows you to select which writing 
styles you want word prediction to use. These vocabulary 
categories are from detailed linguistic research and analysis of 
written and spoken English words.   

To change the writing styles WYNN uses when predicting words 
and phrases: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Lists tab. 
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3. Select the check box next to each writing style you want 
WYNN to use. 

4. Clear the check box next to each writing style you do not 
want to use. 

5. Click the OK button.  

Creating a Custom Toolbar  

To create a new toolbar containing only certain buttons that you 

specify, choose Custom Toolbar from the Settings menu. You 
can have WYNN display this toolbar instead of the standard 
toolbars in order to provide quick access to commonly used 
commands. 

To create a custom toolbar: 

1. From the Settings menu, choose Custom Toolbar.  
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2. In the Available Buttons list, select the first button that 
you want to appear on your custom toolbar. 

3. Click Add to place the button to the Custom Toolbar list. 

You can add up to 14 buttons to a custom toolbar. The 
order in which you choose the buttons is the order in 
which the buttons appears on the toolbar.  

Tip:  To remove a button from the custom toolbar, select it in the 

Custom Toolbar list, and click the Remove button. 

4. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

5. Click the OK button.  

If you want to use this custom toolbar in future WYNN 
sessions, be sure to save your settings. Refer to Saving a 
Custom Toolbar below for more information. You can as 
many toolbars as you need, but be sure to save each 
toolbar under a different name. 
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Tip:  WYNN includes a number of sample custom toolbars 
designed to address several particular task and 

environments. To retrieve these toolbars, choose Retrieve 

Settings from the Settings menu. 

Saving a Custom Toolbar 

After creating a custom toolbar, you can save it for future WYNN 
sessions.  

To save the toolbar: 

1. From the Settings menu, choose the Save Settings 
command.  

The Save the Settings dialog box appears.  

2. Type a name into the Enter new settings file name edit 

box, and click the Save button to save the toolbar.  

In the future, it can be retrieved by: 

¶ Clicking the Settings menu 

¶ Clicking the Retrieve Settings command  

¶ Selecting the toolbar from the Name column 

Applying Preset Toolbars 

WYNN includes a number of sample custom toolbars designed to 
address several particular task and environments.  

To use WYNNôs preset toolbars: 

1. From the Settings menu, choose Retrieve Settings. 

The Retrieve Settings dialog appears. 
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2. Select one of the following Custom Toolbars from the 

Name column. 
 

Custom 

Toolbars 

Toolbar Buttons 

Fluent 
Reading              

       

Public 
Access              

                    

Studying 
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3. Click the OK button. The selected toolbar appears and 
replaces the four default toolbars. 

Improving Auditory Processing Toolbar 

This exercise is an example of how to create a customized toolbar 
to help students hear and improve text processing. Use these 
procedures to instruct students how to create an Auditory 
Processing toolbar for their own user account.  

To create the toolbar: 

1. From the Settings menu, choose Custom Toolbar.  

The Customized Toolbar property page appears.  

2. In the Available Buttons list, select the Read, Rate, and 

Pause icons, and click Add to place the icons in the 
Custom Toolbar list.  

 

3. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

4. Click the OK button.  
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To save the toolbar: 

1. From the Settings menu, choose the Save the Settings 
command.  

2. Type a name into the Enter new settings file name edit 
box (for example, Auditory Processing Toolbar), and click 

the Save button to save the toolbar.  

3. In the future, it can be retrieved by: 

¶ Clicking the Settings menu 

¶ Clicking the Retrieve Settings command  

¶ Selecting the toolbar from the Name column 

Improving Vocabulary Development Toolbar 

To improve a studentôs vocabulary development, you can create a 
custom toolbar specifically for this task. Follow these procedures 
to create a Vocabulary toolbar for your account. You can then 
instruct students to create their own Vocabulary toolbar for future 
assignments. 

To create the toolbar: 

1. From the Settings menu, choose Custom Toolbar.  
 

The Customized Toolbar property page appears.  

2. In the Available Buttons list, select the Dictionary, 

Voice Note, and Read icons, and click Add to place the 
icons into the Custom Toolbar list.  
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3. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

4. Click the OK button.  

To save the toolbar: 

1. From the Settings menu, choose the Save the Settings 
command. 
 

The Save Settings dialog box appears.  

2. Type a name into the Enter new settings file name edit 
box (for example, Vocabulary Development), and click the 

Save button to save the toolbar.  

In the future, it can be retrieved by: 

¶ Clicking the Settings menu 

¶ Clicking the Retrieve Settings command  

¶ Selecting the toolbar from the Name column 
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Personalizing Reading Needs  

There are several functions on the green Reading Styles toolbar 
that can assist a student with reading. You can create a custom 
toolbar that a student can retrieve that contains just those reading 
assistance functions.  

To create a reading assistance toolbar: 

1. From the Settings menu, choose Custom Toolbar.  
 

The Customized Toolbar property page appears.  

2. In the Available Buttons list, select the Size, Line 

Spacing, Word Spacing, Margins and Read icons, and 

click Add to place the icons into the Custom Toolbar list.  
 

 

3. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

4. Click the OK button.  

To save the toolbar: 

1. From the Settings menu, choose the Save the Settings 
command. 
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2. Type a name into the Enter new settings file name edit 
box (for example, Reading Assistance), and click the 

Save button.  

The new toolbar is saved.  

In the future, it can be retrieved by: 

¶ Clicking the Settings menu 

¶ Clicking the Retrieve Settings command  

¶ Selecting the toolbar from the Name column 

Tip:  If you exit WYNN with a Custom Toolbar open, that toolbar 
is active the next time you log in.  

To retrieve your Default Toolbar:  

1. Click the Setting menu, and then the Custom Toolbar 

2. Click the Show Default Toolbars radio button, and then 

OK.  

Creating Bookmarks 

WYNN lets you bookmark important passages of text in a 
document for quick reference.  

To bookmark text in your document:  

1. Create or open an existing document. 
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2. Use your pointer to select a single word or a passage of 

text in the document, and then click the Bookmark 
button.  
 

 
 
Several different bookmark symbols appear.  
 

 

3. Choose a bookmark symbol from the list.  

WYNN places this bookmark symbol at the beginning and 
end of the selected text.  

To erase a bookmark:  

1. Click the Bookmark button and select the eraser at the 
bottom of the list. Your mouse pointer changes into a 
pencil eraser.  

2. Click and drag the eraser over the bookmarked text.  

Tip:  You can search for bookmarks using the Find button 
(Writing Tools toolbar), or create a list of bookmarked text 

using the Lists button (Study Tools toolbar). 
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Highlighting Text 

WYNN allows you to indicate important passages or key words in 
your document or a Web page just as you would highlight text in a 
book.  

To highlight text in your document or Web page:  

1. Click the Highlight button and choose a highlight color 
from the list. Your mouse pointer changes into a 
highlighter pen.  

 

2. Click and drag the highlighter pen over text you want to 
highlight.  

WYNN highlights the text using the color you selected. 
You can highlight a single word by clicking it. 

3. Click the Highlight button again when you are done 
highlighting text to return the cursor to normal.  

To erase highlighting:  

1. Click the Highlight button and then select the eraser at 
the bottom of the list. Your mouse pointer changes into a 
pencil eraser.  

 

2. Click and drag the eraser over the highlighting you want 
to remove. You can erase the highlighting for an 
individual word by clicking the word. 
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Tip:  You can search for highlighted text using the Go To 

command (CTRL+G), or create a list of highlighted text 
with the Lists toolbar button. To print out just the text you 
highlighted in the document, click the Print button and 

select the Highlight Text Only radio button. 

Note:  When you highlight text on the Web, you should print or 
extract the text as soon as possible.  Web documents can 
change quickly, so some or all of the text you highlighted 
might not be there the next time you go to that Web page. 

To print the highlighted text: 

1. Click the Print button (File Management toolbar). 

2. Select the Highlight Text Only radio button. 

Note:  You must be in Text View mode to print highlighted text. 

Note:  If you highlight text on a Web page, you should print the 
highlighted text as soon as possible. 

Creating a Voice Note 

Voice Notes are useful for those with stronger auditory than visual 
processing skills. This feature allows you to use the microphone to 
record a spoken message. Teachers can create Voice Notes 
containing questions, messages, or assignments for students. 
Student can use Voice Notes to record answers to the teacher's 
questions, create reminders, or ask questions about the text. 

Note:  You must connect a microphone to your sound card before 
recording a Voice Note.  

To insert a voice note: 

1. Make sure that your microphone is available and turned 
on.  
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2. Click the location in your document where you want to 
place the note, and then click the Voice Note button from 
the Study Tools toolbar.  
 

 
 

The Voice Annotation dialog box opens at the bottom of 
the WYNN window.  

3. Click Record to begin recording the note, and speak your 
message into the microphone.  

The bar just above the Play, Stop, and Record buttons 
shows the relative length of your recording.  

Click the Stop button when you have finished recording 
the voice note.  

To listen to the note, click Play.  

When you are finished, click OK to add the note.  

4. A Voice Note icon appears where you added the note.  

 

5. Double-click this icon to listen to the note. 

Tip:  You can search for Voice Notes in the document (while in 

Text View mode) by using the Find toolbar button, which 

appears on the yellow Writing Tools toolbar. 

Paraphrasing Using Voice Notes 

Paraphrasing helps students comprehend and retain information. 
Using WYNN's Voice Notes is an invaluable tool when working on 
this learning strategy.  
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The following exercises, which require you to show students how 
to record a Voice Note (page 156), can help students to improve 
comprehension: 

When students have trouble remembering homework 
assignments, have them repeat the directions verbally using Voice 
Notes. This enables you to ensure they understand the oral 
directions. 

Ask students to paraphrase or explain difficult information they are 
going to be tested on using the Voice Notes feature in WYNN. 
Paraphrasing helps to ensure their understanding and mastery of 
the material. 

When learning new vocabulary, encourage students to read the 
definitions of the new word in the dictionary and create a sentence 
using the new vocabulary word in Voice Notes. Verbal repetition 
and sentence use supports vocabulary growth. 

Creating a Text Note 

Text Notes can be added to a document to provide information or 
key instructions about a specific passage of text.  

To insert a Text Note: 

1. Open your document in WYNN.  

2. Click the location in your document where you want to 

place the note, and then click the Note button from the 

pink Study Tools toolbar.  
 

 
 

The Edit Text Note dialog box opens at the bottom of the 
WYNN window.  
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3. Enter text into the Edit box.  

Click Read to have WYNN read the text note aloud.  

Click Paste to paste text from another document into the 
Edit box.  

Click Cancel to discard the text note.  

4. When you are finished, click OK to add the note. 

A Note icon appears where you added the note.  

 

5. Double-click this icon to see the text note. 

Tip:  You can search for Text Notes in the document (while in 

Text View mode) by using the Find toolbar button, which 

appears on the yellow Writing Tools toolbar.  

 You can also paste text copied from other locations into the 
Text Note. For example, you can copy a definition from 
WYNNôs dictionary and paste the text into a Text Note. 

Printing  

To print a document in WYNN: 

1. Open a document in WYNN. 

2. Click the Print button on the blue File Management 
toolbar.  
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3. Choose the printer you want to use to print the document, 
and then specify the parts of the document you want to 
print and the number of copies you want to create. 

Note:  You can choose to print only text that you have highlighted 

in the document by selecting the Highlight Text Only radio 
button. See Highlight Text (page 155) for more information.  

 You can also choose to print only the content of all text 

notes in the document by selecting the Text Notes Only 
radio button. See Creating a Text Note (page 158) for more 
information. 

4. Click the OK button to begin printing. 

Browsing the Web Using WYNN 

WYNN allows you to browse pages on the Internet.  The following 
section describes how to: 

¶ Open a Web page 

¶ Limit the number of Web pages open at a time 

¶ Extract text from a Web page 

To open a Web page: 

1. Click the Go to Web button on the file management 
toolbar. 

  

WYNN displays the Web toolbar and opens your home 
page. 
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2. You can then enter the Web address you want to go to in 
the address bar or search for the Web site using the 
Search button. 

Tip:   You can also select Go to Web from the File menu. 

Note:  If the page displays as a plain text file, then the Web page 
you are trying to view has probably not been formatted 
correctly. Web pages must include the <html> element. 

To limit the number of Web pages open at a time: 

1. Select Web Settings from the Settings menu.  

2. In the Maximum Number of Open Web Pages section, 
select how many Web pages you would like open at one 
time.  
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Note:  You can also use this dialog to set your Home page.  

To extract text from a Web page: 

1. Select the text that you want to extract. 

2. Right-click on the selected text. 

3. Choose "Extract to WYNN document." 

WYNN will open a new document containing the selected 
text. 

Changing a Documentôs Color Settings  

You can change a documentôs text and background colors to help 
students read the document. There are two ways to change color 
settings: use WYNNôs preset color combinations, or manually 
create color combinations.  

Preset Color Combinations 

To use WYNNôs preset color combinations: 

1. Open a document. 

2. From the green Reading Styles toolbar, click the Color 
button.  

 

The color button has the following color combinations: 

¶ Black text on a white background (default) 

¶ Black text on a rose background 

¶ Black text on a beige background 
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¶ Black text on a sky blue background 

¶ White text on a black background 

3. Each time your click the Color button, WYNN cycles 
through the previously mentioned text and background 
color combinations.  

4. Choose an appropriate color combination. 

Changing Colors Manually 

To manually change WYNNôs text and background colors: 

1. From the Settings menu, choose Visual Settings. 
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2. Choose colors from the Text Color and Background 

Color list boxes.  

3. Click OK to save the new colors.  

Converting Documents to MP3 or WAV File 

You can save and convert any document that you can open in 
WYNN as an MP3 or WAV file. This allows a user to listen to a 
document later using an MP3 or WAV compatible device.  

To convert a document to an MP3 or WAV file: 

1. Open a document using WYNN. 

2. Select the File menu and choose the Save to Audio 

command. The Save to Audio dialog box opens. 

 

3. Do one of the following: 

¶ Select the Save current page radio button to convert 
only the current page to an MP3 or WAV file, or  

¶ Click the Save page range radio button to convert the 
entire document or a range of pages to an MP3 file. 

Select Save range as a single file to create one audio 
file. 
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4. Click OK. The Save As dialog box opens.  

5. Enter a file name in the File name edit box, and click the 

Save button. WYNN converts the text to audio and saves 
the file into your user directory as an MP3 or WAV file.  

To listen to the file: 

1. Click your WYNN file folder icon, which appears on your 
desktop. 

2. Double-click the MP3 or WAV file.  

3. The file opens using your default audio player.  
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Student Exercise Guide 

This section describes how to perform basic tasks using WYNN.  

Cutting or Copying and Pasting Text 

The Cut/Paste button allows you to cut, copy, and paste text. You 

must enter Write mode to cut or paste text. 

To copy text: 

1. While in Write mode, select text in the document.  

  This indicates that Write mode is active. 

2. Click the Cut/Paste button.  

 

The Cut, Copy, and Paste options appear. 

¶ Choose Cut to delete the text and move it to the 
Clipboard.  

¶ Choose Copy to leave the selected text in the 
document and copy it to the Clipboard. 

The Clipboard is a temporary storage area that stores text 
that you want to move. The Clipboard can only hold one 
thing at a time. For example, if you copy text and then cut 
different text, the Clipboard only contains the text that you 
cut. 

3. Once you copy or cut text on to the Clipboard, you can 
paste it into a document (see the following procedures). 

Tip:  You can use the shortcut keystroke CTRL+C to copy text. 
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To paste text: 

1. Move the cursor to the place in the document where you 
want to insert the text.  

2. Click the Cut/Paste button and select Paste to insert the 
contents of the Clipboard into your document.  

You can continue to paste the contents of the Clipboard 
until you cut or copy different text. You can also paste the 

text into another WYNN document. Just click the Other 

Docs button to bring up the left side navigation bar (File 
List). Switch documents and then paste the text into the 
desired location. 

  

Tip:  You can paste text from WYNN into other applications, 
such as Microsoft Word.  

Tip:  You can use the shortcut keystroke CTRL+V to paste. 

You can also paste text from other applications into 
WYNN. Use the copy, cut, and paste commands in the 
other applications just as you would use them in WYNN. 
These commands usually appear on the application's Edit 
menu. 

Creating a Vocabulary List Using Bookmarks 

Use the Bookmark button to select specific words from a 
document, and use the Lists button to add the words to a new file.   
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Selecting Words using Bookmarks 

To select words for the vocabulary list:  

1. Open a document.  

2. From the Study Tools toolbar, use the Bookmark button 
to select words that appear in the document.  

 

3. Highlight a word or phrase. For example, 

 

4. Click the Bookmark button, and choose a bookmark 
symbol. 

 

5. The bookmark symbols appear at the beginning and end 
of the selected text. For example,  

 

6. Repeat steps 2 through 4 to bookmark additional words 
and phrases. 

When finished, go to the next section to create the 
vocabulary list file. 
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Creating the Vocabulary List using Bookmarks 

WYNN allows you to create a new document containing text you 
have highlighted or bookmarked. You can use this feature to make 
lists of topic sentences, vocabulary words, useful facts, and more.  

To create the vocabulary list file: 

1. Click the Lists button and choose the type of list you 
want to create and how you want to sort it. 

 

2. Choose to list the text by bookmark symbol or by the 
order that you bookmarked the text.  

 

¶ By Bookmark Type - Creates a list of all bookmarked 
words or phrases from the original document. WYNN 
sorts the text into individual lists separated by 
bookmark type. 

¶ By Bookmark Order - Creates a list of all bookmarked 
words or phrases arranged in the order they appear in 
the original document 

3. After selecting the type of list sort, WYNN creates a new 
document containing the bookmarked vocabulary words.  

The new document uses the initial fileôs name, but adds 
the suffix ïlistx, where x is 1, 2, 3, and so on. For 
example, Flower Parts-list1.wyx. 
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Note:  If you have more than the maximum number of documents 
open, WYNN asks you to save your changes to the 
document you have accessed the least recently and then 
closes it. 

Finding a Word in the Dictionary  

There are several ways to find the definition of a word in WYNN. 

¶ On the Study Tools toolbar, select the Dictionary button, 

and choose the Basic Dictionary or the Standard 

Dictionary 

¶ Select the Tools menu and choose the Basic Dictionary 
command 

¶ Select the Tools menu and choose the Standard 

Dictionary command 

¶ Press the F4 function key to select the Standard 

Dictionary.  

The following procedure uses the Dictionary button to look up 
definitions for words in your WYNN document:  

1. Click a word, and then from the pink Study Tools toolbar, 

click the Dictionary button. 

 

2. Choose Basic (5th grade level) or Standard (7th to 8th 
grade level).  

The dictionary entry for the selected word displays in the 
Dictionary box at the bottom of the WYNN window. It 
shows the wordôs syllables, parts of speech, and 
definition.  
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Click Read Word to have WYNN read the word aloud. 

Click Switch to Synonyms to switch to WYNNôs 
thesaurus.  

Tip:  If you want to define a word within the definition, double-
click the word to retrieve the definition for that word. Click 

the Previous Look-up button to return to the original word. 

3. When you finish working with the dictionary, click Close 
to return to your document. 

Finding a Word in the Thesaurus 

There are several ways to look up a word in WYNNôs thesaurus.  

¶ Click the Switch to Synonyms button on the Dictionary 
box.  

¶ Select a word and choose Thesaurus from the Tools menu. 

¶ Select a word and press SHIFT+F4.  

The following procedure uses the Thesaurus command from the 
Tools menu to find synonyms for a selected word.   

1. Select a word in your WYNN document.  

2. Click the Tools menu and select the Thesaurus 

command. The Thesaurus box opens at the bottom of 
the WYNN window.  

3. Click the scroll bar in the Synonyms text box to view a 
list of synonyms for the selected word.  

Use the Readï> button, which reads the next word in the 

Synonym list, and Read <ï button, which reads the 
previous word in the Synonym list, if you want WYNN to 
read the list of synonyms to you.  
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Click Switch to Definition to start the Dictionary to see 
the wordôs syllables and part of speech.  

4. Click Close to return to your document when you are 
finished with the Thesaurus. 

Hearing Text as You Type  

You can customize how WYNN reads documents, menus, dialog 
boxes, toolbar buttons, and messages. 

Note:  Some of these speech options may not be available, 
depending on the synthesizer you have selected. If an 
option is not available for your synthesizer, it is grayed-out.  

1. Select the Speech Settings command from the Settings 
menu.  

2. Use the Read Aloud As I Type combo box to control how 
WYNN repeats what you type.  

 

Choose one of the following: 

¶ Off - WYNN does not speak any text you type.  

¶ Character - WYNN speaks each character you type.  

¶ Word - WYNN speaks each complete word you type 

after you press SPACEBAR.  

¶ Character and Word - WYNN speaks each character 
you type and then reads the word you typed.  
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¶ Sentence - WYNN reads back the last sentence you 
typed.  

¶ Word and Sentence - WYNN speaks each word you 
type and then reads the entire sentence.  

3. Click OK.  

Controlling What WYNN Speaks 

You can control which parts of the user interface that WYNN 
speaks aloud as you select menus, text, and toolbars and receive 
WYNN informational or error messages.  

By default, WYNN speaks only the text of the document when you 

click the Read button. If you wish to have additional information 
spoken, do the following to select which parts of the user interface, 
documents, and messages WYNN speaks aloud:  

1. Select the Speech Settings command from the Settings 
menu. 

2. Use the Text, Menus & Dialogs, Toolbar Buttons, and 

Messages check boxes to select what WYNN speaks 
when moving through the WYNN window.  

 

3. Select one or more of the following, and then click Ok. 
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Speak 

What?  

Check this item if é  

Text You want WYNN to read documents aloud.  

NOTE: If this is check box is cleared, 
WYNN does not read the document aloud 

when you click the Read button. 

Menus & 
Dialogs 

You want WYNN to speak aloud as you 
select menus and dialog boxes 

Messages You want WYNN to speak aloud 
informational and error messages. 

Toolbar 
Buttons 

You want WYNN to speak aloud the name 
of the toolbar button as you hover the 
mouse pointer over it 

Highlighting Text 

WYNN allows you to indicate important passages or key words in 
your document or Web page just as you would highlight text in a 
book.  

To highlight text in your document or Web page:  

1. Click the Highlight button on the pink Study Tools 

toolbar or on the Web toolbar, and choose a highlight 
color from the list.  

Your mouse pointer changes into a highlighter pen.  

 

2. Click and drag the highlighter pen over text you want to 
highlight, or use it to click and highlight a single word.  
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WYNN highlights the text using the color you selected.  

3. Click the Highlight button again when you finish 
highlighting text to return the pointer to normal.  

To erase highlighting:  

1. Click the Highlight button and then select the Eraser at 
the bottom of the list.  

Your mouse pointer changes into a pencil eraser.  

 

2. Click and drag the eraser over the highlighting you want 
to remove. You can erase the highlighting for an 
individual word by clicking the word. 

3. Click the Highlight button again when you finish erasing to 
return the pointer to normal.  

To create a list of the highlighted text:  

1. Click the Lists button on the Study Tools toolbar. 

 

2. Choose to list the text by highlighted color or by highlight 
order.  
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¶ By Highlight Color - Creates a list of all highlighted 
words or phrases. Text highlighted in green appears 
first in the list, text highlighted blue appears second, 
and text highlighted in magenta appears last. 

¶ By Highlight Order - Creates a list of all highlighted 
words or phrases in the order they appear in the 
original document.  

A dialog box opens that allows you to save the extracted 
text to a new file.  

 

3. Click the New WYNN Document button.  

The highlighted words are saved to a separate file. This 
new document uses the initial fileôs name, but adds the 
suffix ïlistx, where x is 1, 2, 3, and so on. For example, 
Flower Parts-list1.wyx. 

To search for highlighted text: 

Note:   You must be in Text View to search for highlighted text or 
other markup. 

1. From the Edit menu, choose Go To.  
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2. The Go to What dialog box opens.  

Note: You can also press CTRL+G to open the dialog box.  

3. In the Go to What list, select Highlight, and then choose 
the type of highlight to find in the document. 

 

Important:  
The options available in the dialog box will change as you 
select different items in the list. Follow the instructions that 
display with the selected item to narrow your search. For 
example, when Page is selected in the list, you can type a 
specific page number to go directly to that page.  

4. Click the Go button associated with the item in the Go to 
What list to begin the search. The search begins at the 
location of your cursor and goes to the first occurrence of 
the mark-up in the active document. You can click the 
document to move your insertion point and then make 
changes. This is only valid in Write mode.  

5. Click Previous or Next to continue the search.  

6. Click Close when you are finished.  

To print the highlighted text: 
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1. Click the Print button (blue File Management toolbar). 

2. Select the Highlight Text Only radio button. 

 

Note:   You should print Web text as soon as possible. 

Listening to Voice Notes 

A Voice Note is a recorded message that appears in the 
document. The following icon represents a Voice Note.  

 

It may contain instructions from your teacher advising you about 
the exercise.   

To listen to a Voice Note: 

1. Locate and double-click the Voice Note icon. 

The Voice Annotation box displays at the bottom of the 
WYNN window and begins to play the recorded message.  

2. Click the Play button to hear the message again. 

3. Click the Cancel button to close the dialog box and return 
to your document.  
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Making Text Bigger 

To increase the text size that appears on your screen: 

1. Click the Size button from the green Reading Styles 
toolbar. 

 

The print becomes larger on the screen.  

2. Continue to click the Size button until a comfortable sized 
text appears. The Size function supports eight different 
sizes of text: 10, 12, 14, 20, 24, 28, 40, and 60 point.  

Continual clicking of the Size button scrolls through the 
eight different text sizes.   

Masking a Document 

Masking is a special tool that shades certain parts of the 
document and Web page in order to better focus on the current 
line, sentence, or paragraph as it is being spoken.  

Note: You can only use masking in Text View mode. 

Also, when the Write button  is available in the blue 
File Management toolbar, Text View mode is on.  

To mask text in a document: 

1. Open a document, and, if necessary, place your pointer 
at the beginning. 
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2. Select the green Reading Styles toolbar, and click the 

Mask button to cycle through the different masking 
options. 
 
The four masking options are:  

¶ No masking - No masking is applied to the document. 

¶ Line masking - Shades all text except the line where 
the cursor is currently located. 

¶ Sentence masking - Shades all text except the 
sentence where the cursor is currently located. 

¶ Paragraph masking - Shades all text except the 
paragraph where the cursor is currently located. 

3. Do one of the following: 

¶ Click the text in the document and read it, or 

¶ Click the Read button or press F2 to have WYNN read 
the text to you.  

 

Note:  If you turn masking on and then switch to Write mode, you 
cannot access certain WYNN commands, such as 
highlighting and bookmarks. Be sure to turn masking off 

before switching to Write mode if you want to use these 
commands. You can turn masking back on at any time. 

To turn off masking: 

1. Click the Mask button until no background masking 
appears in the document.  

Tip:  To make the shaded background and text lighter or darker, 

choose Masking from the Settings menu.  
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Adjusting Background Masking 

The background shading used for masking is adjustable.  

To make the background or text lighter or darker: 

1. Choose Visual Settings from the Settings menu. The 
background masking options are located in the middle of 
the Visual Settings page.  

 

2. Use the Document Increment combo box to select how 
much text to mask. For example, by line, sentence, or 
paragraph.  

Use the Text Color slider to make the text lighter or 
darker. 

Use the Background Color slider to make the 
background lighter or darker.  

Use the Preview pane at the bottom of the Visual 
Settings page to view your text and background 
adjustments.  

3. After completing the adjustment, click Apply to apply the 

new settings or click OK to apply changes and close the 
Visual Settings page.  
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Opening a Web Page Using WYNN 

WYNN allows you to browse and read pages on the World Wide 
Web, mask and read Web pages, and highlight and extract text 
from Web pages.  

Start WYNNôs Web Browser 

To begin browsing the Web: 

1. Click the Go To Web button on the blue File Management 
toolbar. 

 
 
WYNN displays the Web toolbar and opens your home 
page.  

 

2. Click any link on your home page to visit other Web 
pages. If you know the Web address of a page you want 

to visit, click the Go To Page button on the Web toolbar. 
Type the full Web address of the page and then click the 

Go button.  
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3. If you do not want to visit a specific Web address, you 
can search the Internet for pages containing the 

information you need. Click the Search button on the 

Web toolbar. Enter words or phrases you want to search 

for and click the Search Now button. WYNN submits the 
search to Google.com and displays the results. Click one 
of the links in the list of search results to jump to the Web 
page. 

Tip:   You can change the Spotlight color using the Visual 

Settings property page. 

Note:   If the page displays as a plain text file, then the Web page 
you are trying to view has probably not been formatted 
correctly. Web pages must include the <html> element. 

Automatically complete Web addresses 

WYNN can automatically complete Web addresses typed into the 
address bar.  You must have visited the Web page before for the 
Auto Complete function to work. 

To turn Auto Complete on or off: 

1. Open the Settings menu and choose Web Settings. 

2. Select or clear the Auto-complete Web Addresses 
check box. 

 

Change your current home page 

To change your current home page: 

1. Choose Web Settings from the Settings menu.  
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2. Type the address of the page you want to set as your 

home page, or click Use Current if the current page is 
the one you want to use as your home page. 

 

3. Click Ok to apply these settings. 

Mask Web Pages 

To mask text in a Web page: 

1. Open a Web page and place your pointer where you 
would like to begin reading 

2. Click the WebMask button to cycle through the four 

different masking options: No WebMasking, Line 

WebMasking, Sentence WebMasking, and Paragraph 

WebMasking. 

  

3. Do one of the following: 

¶ Click the text in the document and read it, or 

¶ Click the Read button or press F2 to have WYNN read 
the text to you. 

Tip:   See Adjusting Background Making, described earlier in this 
document, to customize the WebMask. 
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Read Web Pages 

1. Click the Read toolbar button if you want WYNN to read 
the page aloud. 

2. You also have access to some of WYNN's study tools, 

such as the Dictionary, Highlight, and Lists buttons to 
aid your Web research.  

3. In addition, you can copy text, find text in the page, print 
the page, or switch to another open document.  

4. If you want to return to your home page, click the Home 
button on the Web toolbar. 

5. When you are finished browsing the Internet, click the 

Close Web button on the Web toolbar. 

To Change the Spotlight color: 

1. Choose Visual Settings from the Settings menu. 

2. In the Visual Settings property page change the spotlight 
color and spotlight background color dropdown boxes to 
change them. 

Read Hyperlinks 

To read hyperlinks on a Web page without activating them: 

1. Mouse-over or press TAB to move to the hyperlink. 

2. After a slight delay, WYNN reads the hyperlink text. 

Note:   WYNN must not be reading the page to read hyperlinks 

To turn read hyperlinks off or on: 

1. Open the Settings menu and select Web Settings. 
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2. Clear the Read Hyperlinks check box to turn it off. 

Select the Read Hyperlinks check box to turn it on. You 
can also set a brief delay before WYNN reads a 
hyperlink. 

 

3. Select OK. 

Highlight a Web Page 

To Highlight Text on a Web page: 

1. Click the Highlight button on the Web toolbar, and 
choose a highlight color from the list.  

Your mouse pointer changes into a highlighter pen.  

 

2. Click and drag the highlighter pen over text you want to 
highlight, or use it to click and highlight a single word.  

WYNN highlights the text using the color you selected.  

3. Click the Highlight button again when you finish 
highlighting text to return the pointer to normal.  

Tip:   Extract text from Web pages as soon as possible because 
online text frequently changes. 

Extract Text from a Web page 

To extract text from a Web page: 
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1. Click the Extract button. 

 

2. Choose how you want highlights ordered or what you 
want to extract: 

¶ By Highlight Color - Creates a list of all highlighted 
words or phrases. Text highlighted in green appears 
first in the list, text highlighted blue appears second, 
and text highlighted in magenta appears last. This 
choice is useful for categorizing information. 

¶ By Highlight Order - Creates a list of all highlighted 
words or phrases in the order they appear in the 
original document. This choice is useful for creating 
study guides with key points and supporting points. 

¶ All Text - Extracts all text on the Web page to a 
document. You can extract the text into a new 
document or append it to an existing document. 

¶ Selected Text ï Extracts selected text on the Web 
page to a document. You can extract the text into a 
new document or append it to an existing document. 

A dialog box opens that allows you to save the extracted 
text to a new file.  
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3. Click the New WYNN Document button.  

The highlighted words are saved to a separate file. This 
new document uses the initial fileôs name, but adds the 
suffix ïlistx, where x is 1, 2, 3, and so on. For example, 
Literacy, Reading, Writing, & Teaching solutions software 
- Learning Systems Group-list1.wyx. 

Organizing Ideas with Outlines  

Outlines can help you organize the topics and supporting points of 
your documents. You can use outlines to plan the organization of 
research papers, summarize study materials, create plots for 
stories, and more. 

To create a new outline: 

1. Click the Outlines button from the yellow Writing Tools 
toolbar.  
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WYNN opens a new outline document in Write mode. 
WYNN names the new document for you (for example, 
Document-outline1.wyn), but you can change this name 
when you save the outline. 

Note:  If you already have the maximum number of documents 
open, WYNN prompts you to save your changes to the 
document you have accessed the least recently and then 
closes it.  

2. The new document is blank except for the first line; it 

contains the text [Title].  

3. Type a new title for the outline, and press ENTER.  

WYNN automatically numbers the first line in the outline 
with the Roman numeral one (I).  

4. Type the information that you want to appear at this level 

of the outline and then press ENTER.  

WYNN automatically numbers the next line with the 
Roman numeral two (II).  

5. Continue adding lines to the outline until you are finished. 

You can press TAB to begin a new outline level. Use the 

Adjust button to move items in the outline.  

 

WYNN has five outline levels:  

¶ Outline Level 1 - Roman numerals (I, II, III...) 

¶ Outline Level 2 - Upper case letters (A, B, C...) 

¶ Outline Level 3 - Arabic numbers (1, 2, 3...) 

¶ Outline Level 4 - Lower case letters (a, b, c...) 
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¶ Outline Level 5 - Lower case Roman numerals (i, ii, 
iii...) 

Tip:  If you need additional assistance with WYNN's outline 
feature, refer to the Outline Tutorial in WYNNôs online help 
file. 

Predicting the Next Word 

Word prediction helps you write by making spelling suggestions 
and anticipating the next word you are going to type. This feature 
can help you with spelling, grammar, and formulating sentences. 

To start word prediction: 

1. Click the Predict button from the yellow Writing Tools 
toolbar to activate WYNN's Word Prediction feature.  
 

 

The first time you start Word Prediction during a session, 
WYNN loads the word list. After the word list loads, 
WYNN displays a small prediction box on your screen.  

 

The prediction box follows your cursor as you type. If your 
cursor is within or is adjacent to a word, Word Prediction 
suggests alternative spellings for the word.  
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If your cursor is not within or is adjacent to a word, Word 
Prediction suggests ideas for the next word in your 
sentence. 

2. To insert a word that appears in the prediction box, click 
the word you want to insert, or press the corresponding 

function key (F1, F2, F3, etc.).  

WYNN inserts the specified word into your document.  

3. If you want WYNN to read the list of words to you, click 

the Speak List button.  

 

You can also right-click a word in the prediction box to 
have WYNN read the word aloud.  

Note:  To modify the behavior and appearance of the Word 

Prediction feature, choose Word Prediction Settings from 

the Settings menu. To customize the word and phrase 
suggestions provided by the Word Prediction feature, 

choose Word Prediction Teacher Controls from the 

Advanced menu. 

Printing a Document in WYNN 

To print using WYNN: 

1. Click the Print button from the blue File Management 
toolbar to print the active document.  
 

 

2. Choose the printer you want to use to print the document.  
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If necessary, specify which parts of the document you 
want to print and the number of copies you want to 
create.  

3. Click OK to begin printing. 

Proofreading Your Writing Using Speech 

A review of your document with WYNNôs speech function turned 
on is one way of finding and correcting errors.  

To proofread your document: 

1. Open your document and make sure that your computerôs 
speakers are turned on or that your headphones are 
plugged in.  

2. Place your mouse pointer at the beginning of your 

document, and click the Read button.  

WYNN reads your document.  

To change WYNNôs reading speed:  

1. Click the Speech Settings command from the Settings 
menu. 
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2. Change the Rate setting using either the slider or your 
keyboardôs arrow keys.  

The speech rate appears below the slider scale as words 
per minute (WPM). 

3. Click the Test button to verify if the speech rate is too 
slow or too fast.  

4. Click OK when you are satisfied with the speech rate.  

Reading Syllables 

You can use WYNN to divide words into individual syllables and 
display the word's phonetic spelling.  
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To see the syllables and the phonetic spelling of a word: 

1. Click a word in the document, and then click the 

Syllables button in the pink Study Tools toolbar. The 

Syllabify box opens at the bottom of the WYNN window.  

2. Click Read Word to have WYNN speak the word aloud.  

3. Click Read Phonetics to have WYNN speak the wordôs 
phonetic pronunciation aloud.  

4. When you are finished, click Close to return to your 
document. 

Check Your Spelling as You Type 

WYNN can check for misspellings as you type. The misspelled 
words appear in blue text for easy identification and quick 
correction. 

To turn on spell checking as you type: 

1. From the Settings menu, select the General Settings 
command.  

2. Select Check spelling as I type.  

 

3. Open a new or existing document and begin typing.  

If you misspell a word, it appears in blue text. For 
example, 

This is a misspelled word. 
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4. Right-click your mouse on the misspelled word.  

The Spelling options appear.  

 

5. Do one of the following: 

¶ Select the appropriate spelling 

¶ Ignore the misspelled word 

¶ Add the word to your personal dictionary 

¶ Open WYNNôs Spell Checker (see below) 

¶ After choosing the appropriate option, look for the next 
misspelled word and repeat this process, or continue 
typing.  

Spell Checking Your Document 

To check your document for spelling errors: 

1. Place your mouse pointer at the beginning of the 
document.  

¶ Click the F7 function key, or  

¶ Click the Spell Check command from the Tools menu. 
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WYNN checks your document for spelling errors. If an 

error is found, the Spell Check dialog box opens.  

2. Select one of the following options.  

¶ Word Not Found: Shows the misspelled word.  

¶ Replace With: Use the List box arrow to view 
suggested spelling corrections. 

¶ Spell Misspelled Word: Click to have WYNN speak 
aloud, spell aloud, and speak aloud again the 
misspelled word. 

¶ Spell Replacement Word: Click to have WYNN speak 
aloud, spell aloud, and speak aloud the replacement 
word.  

¶ Ignore: WYNN does not correct the misspelling of this 
particular word.  

¶ Ignore All: WYNN does not correct the misspelling of 
this word throughout the document for the remainder 
of the session.  

¶ Replace: WYNN replaces the misspelled word with the 

word chosen in the Replace With list box.  

¶ Replace All: WYNN replaces the misspelled word with 

the word chosen in the Replace With list box 
throughout the document.  

¶ Add to Dictionary: WYNN adds the word that appears 

in the Word Not Found list box to the userôs personal 
dictionary.  

¶ Close: Closes the Spell Check dialog box and returns 
you to the document.  
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3. After you choose to ignore, replace, or add the word to 
WYNNôs dictionary, the spell checker searches for the 
next misspelled word.  

The message ñSpell checking is completeò appears when 
WYNN finishes.  

Spelling a Word 

If you are unfamiliar with a word in a document, use the Spell 
function to have WYNN speak, spell, and speak again the word.  

To spell a word:  

1. Click a word in your document. 

2. Click the Spell button that appears on the pink Study 

Tools toolbar.  

The Spell Word box opens at the bottom of the WYNN 
window. WYNN speaks the word aloud, spells the word, 
and then speaks the word again.  

3. Click Repeat to hear the spelling again. 

4. Click Close when finished.  

Choosing the Correct Word 

A homophone is two or more words that are pronounced alike, but 
have different meaning and often-different spelling. Use WYNNôs 
Homophone function to verify the correct word usage in your 
document.  

To check your document for homophones: 

1. Open a document in WYNN.  

2. Do one of the following to start the homophone function: 
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¶ Click the Homophones button in the yellow Writing 

Tools toolbar 
 

, or  

¶ Select the Homophones command from the Tools 
menu.  

WYNN searches your document, from your current 
mouse pointer position, for homophones. When one is 

found, the Homophones: Sound-alike Words box opens 
at the bottom of the WYNN window. It contains a list of 
homophones and definitions, which allows you to select 
and use the appropriate word.  

3. Click each homophone that appears and read its 

definition in the Definition list box, or click the Read 

Definition button to have WYNN speak the definition to 
you.  
 

You can also click the Read Sentence button to have 
WYNN speak the sentence the homophone was found in. 

4. Click the Skip button if the correct word is used.  You can 

also choose Skip All to skip all instances of the 
homophone in the document. 

If the wrong word is used, choose the word from the 

Homophones list box and click Replace.  

After selecting, WYNN continues to search for the next 
homophone.  

5. To stop the homophone search, click Close to return to 
your document. 
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System Requirements 

The recommended minimum system requirements are listed 
below.  

Operating System 

¶ 32- and 64-bit versions of Windows® 7, Windows Vista®, and 
Windows Server® 2008 

¶ 32-bit versions of Windows XP and Windows Server 2003 

Processor speed 

¶ 500 MHz Intel®  Pentium® or faster 

Memory (RAM) 

¶ 512 MB recommended 

Available hard drive space for installation 

¶ 1.2 GB (on the hard drive containing the Program Files and 
Windows folders) 

Video 

¶ 16-bit high color mode or greater 

Sound 

¶ Windows compatible sound card and speakers 

Acquisition device (optional) 

¶ A TWAIN scanner or the PEARL camera from Freedom 
Scientific (for WYNN Wizard) 
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DVD drive  

¶ Required for product installation. However, it is possible to 
copy the WYNN DVD contents to a USB thumb drive. This is 
the preferred installation method for netbooks and other 
computers that do not have CD or DVD drives. 

Network Server (for Network WYNN) 

¶ 32- and 64-bit versions of Windows® 7, Windows Vista®, and 
Windows Server® 2008 

¶ 32-bit versions of Windows XP, Windows Server 2003, and 
Novell Netware 6.0  

¶ 2.5 GB hard drive space, plus additional space for user files.  

Network Client (for Network WYNN) 

¶ TCP/IP network connectivity to the license server 

License Server (for Network WYNN) 

¶ 32-bit Windows XP or later 
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WYNN Shortcut Keys 

This section lists keystrokes you can press to perform various 
functions in WYNN. In addition to these keystrokes, all standard 
Microsoft Windows shortcut keys are available. 

General Commands 

General Commands Shortcut Keys 

Start WYNN ALT+CTRL+W 

Quit WYNN ALT+F4 

Switch between Text View and Exact 
View 

CTRL+SHIFT+

V 

Show/Hide Menu Bar SHIFT+F3 

Show/Hide Status Bar SHIFT+F5 

Help F1 

Speech Commands 

Speech Commands Shortcut Keys 

All speech options 
(text, toolbars, menus, dialog boxes, 
messages) 

ALT+G, P, 

ALT+A 

Begin/Stop Reading F2 

Toolbars ALT+G, P, 

ALT+T 

Menus and Dialog boxes ALT+G, P, 

ALT+M 
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File Management Commands 

File Management Commands Shortcut Keys 

Open File CTRL+O 

Close Document CTRL+F4 or 

CTRL+W 

Create New Document CTRL+N 

Save Document CTRL+S 

Print CTRL+P 

View Document Properties CTRL+R 

Reading and Editing Commands 

Reading and Editing Commands Shortcut Keys 

Begin Reading F2 

Switch between Read-only Mode 
and Edit Mode 

CTRL+E 

Go to Page CTRL+G 

Undo CTRL+Z 

Copy Selected Text CTRL+C 

Cut Selected Text CTRL+X 

Paste Text from  
Clipboard 

CTRL+V 

Select All CTRL+A 

Delete Selected Text DELETE 
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Reading and Editing Commands Shortcut Keys 

Bold Selected Text CTRL+B 

Italicize selected Text CTRL+I 

Underline Selected Text CTRL+U 

Find Text CTRL+F 

Find/Replace Text CTRL+H 

Insert Page Break CTRL+ENTER 

Delete Page Break CTRL+SHIFT+ENTER 

Delete Current Page CTRL+DELETE 

Look Up Selected Word in the 
Standard Dictionary 

F4 

Look Up Selected Word in the 
Thesaurus 

SHIFT+F4 

Spell Check F7 

Spell Word F6 

Mark-up Commands 

Mark-up Commands Shortcut Keys 

Go To (Any Markup) CTRL+G 

Highlight Selected Text F8 

Insert Bookmark F9 

Insert Text Note F10 

Insert Voice Note F11 
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Acquisition Commands 

Command Shortcut Keys 

Acquire (Scan) a Page F3 

Switch between Text View and Exact 
View 

CTRL+SHIFT+V 

Document Clean-up SHIFT+F7 

Enable Dynamic Zoning and Show 
Current Zones 

CTRL+F5 

Redefine Zones on Current Page CTRL+D 

Re-recognize Document CTRL+Q 

Study Tools Commands 

Command Shortcut Keys 

Dictionary F4 

Spell Current Word F6 

Spell Checker F7 

Highlight F8 

Insert Bookmark F9 

Create Text Note F10 

Create Voice Note F11 



 WYNN Shortcut Keys 

 

  205  

PEARL Camera Commands 

Command Shortcut Keys 

Acquire (Scan) and Read Page F3 

Stop Automatic Acquisition ESC 

Cycle Among Text View, Exact 
View, Split View, and Camera View 

CTRL+SHIFT+V 

Increase Zoom (press and hold for 
continuous zoom) 

CTRL+PLUS or 

CTRL+SHIFT+MOUSE 

WHEEL FORWARD 

Decrease Zoom (press and hold for 
continuous zoom) 

CTRL+MINUS or 

CTRL+SHIFT+MOUSE 

WHEEL BACKWARD 

Rotate Camera View Right CTRL+SHIFT+R 

Rotate Camera View Left CTRL+SHIFT+L 

Grab Image and Move in any 
Direction 

ALT+LEFT MOUSE 

BUTTON (press and 
hold) 

Incremental Pan View Down  
WINDOWS 

Key+CTRL+DOWN 

ARROW 

Incremental Pan View Up  
WINDOWS 

Key+CTRL+UP 

ARROW 

Incremental Pan View Left 
WINDOWS 

Key+CTRL+LEFT 

ARROW 
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Command Shortcut Keys 

Incremental Pan View Right 
WINDOWS 

Key+CTRL+RIGHT 

ARROW 

Continuous Pan View Down 
WINDOWS 

Key+DOWN ARROW 

Continuous Pan View Up 
WINDOWS Key+UP 

ARROW 

Continuous Pan View Left 
WINDOWS Key+LEFT 

ARROW 

Continuous Pan View Right 
WINDOWS 

Key+RIGHT ARROW 

Increase Speech Rate CTRL+ALT+PAGE UP 

Decrease Speech Rate 
CTRL+ALT+PAGE 

DOWN 

Toggle Camera LED On or Off CTRL+L 
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WYNN Menus 

This section lists each command available on the WYNN main 
menu bar. The second column lists the shortcut keys you can 
press to quickly activate the corresponding command. 

File Menu (ALT+F) 

File Menu Commands Access Keys 

New ALT+F, N 

Open ALT+F, O  

Close ALT+F, C 

Save ALT+F, S  

Save As ALT+F, A 

Save to Audio ALT+F, D 

Save Pages ALT+F, G 

Login Different User ALT+F, L 

Append File to Current Document ALT+F, F 

Export Highlights ALT+F, I 

Export Bookmarks ALT+F, B 

Export Text Notes ALT+F, E 

Print ALT+F, P 

Print Preview ALT+F, V 

Document Properties ALT+F, R  

Exit ALT+F, X 
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Edit Menu (ALT+E) 

Edit Menu Commands Access Keys 

Edit Mode/Read-only Mode ALT+E, E 

Undo ALT+E, U  

Cut ALT+E, T 

Copy ALT+E, C 

Paste ALT+E, P 

Delete ALT+E, D 

Select All ALT+E, S  

Bold ALT+E, B  

Italic ALT+E, I  

Underline ALT+E, U  

Find Text... ALT+E, F  

Find/Replace Text... ALT+E, R  

Find Mark-up... ALT+E, M  

Go to Page... ALT+E, G  

Renumber Pages... ALT+E, A 

Insert Page Break ALT+E, B  

Delete Page Break ALT+E, K  

Move Page... ALT+E, M 

Delete Current Page ALT+E, L  
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Edit Menu Commands Access Keys 

Create Outline  ALT+E, O 

Outline Adjustments ALT+E, J 

Acquire Menu (ALT+S) 

Acquire Menu Commands Access Keys 

Workflow ALT+S, W 

Acquire Page ALT+S, A  

Acquire and Replace Current Page ALT+S, R 

Acquire and Insert New Page ALT+S, I 

Recognize Columns ALT+S, Z 

Split Facing Pages ALT+S, F 

View Menu (ALT+V) 

View Menu Commands Access Keys 

Show Exact View ALT+V, E  

Show Text View ALT+V, T 

Split View ALT+V, L 

Camera View ALT+V, C 

Hide Study Tools in Exact View ALT+V, H 

Menu Bar ALT+V, M  

Toolbar ALT+V, T 

Two Tone ALT+V, O 
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View Menu Commands Access Keys 

File List AVT+V, F 

Zoom Exact View ALT+V, Z 

Page Scrolling ALT+V, P 

Tools Menu (ALT+T) 

Tools Menu Commands Access Keys 

Start Reading ALT+T, S  

Spell Check ALT+T, P  

Spell Check As I Type ALT+T, E 

Word Count... ALT+T, R 

Spell Word... ALT+T, W  

Syllabify Word... ALT+T, Y 

Homophones ALT+T, M 

Word Prediction ALT+T, O 

Basic Dictionary... ALT+T, B  

Standard Dictionary... ALT+T, D  

Thesaurus... ALT+T, T  

Start Highlight ALT+T, H  

Highlighter Pens ALT+T, G 

Lists ALT+T, L 

Insert Bookmark ALT+T, I  



 Activation Options 

 

  211  

Tools Menu Commands Access Keys 

Bookmark Type ALT+T, B 

Insert Text Note... ALT+T, N  

Insert Voice Note... ALT+T, V 

Advanced Menu (ALT+A) 

Advanced Menu Commands Access Keys 

Pronunciation Dictionary ALT+A, P  

Dynamic Zoning ALT+A, Z 

Document Cleanup ALT+A, D 

OCR Correction... ALT+A, O 

Scanner Selection... ALT+A, S 

Teacher Lockout ALT+A, T 

Word Prediction Teacher Controls... ALT+A, W 

Settings Menu (ALT+G) 

Settings Menu Commands Access Keys 

Save Settings... ALT+G, S 

Retrieve Settings... ALT+G, R 

Delete Settings... ALT+G, D 

Speech Settings... ALT+G, P 

Visual Settings... ALT+G, V 

Scanning Settings... ALT+G, C 
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Settings Menu Commands Access Keys 

General Settings... ALT+G, G 

Masking... ALT+G, M 

Differential Coloring... ALT+G, O 

Word Prediction... ALT+G, I 

Custom Toolbar... ALT+G, T 

Web Settings... ALT+G, W 

Web Menu (ALT+B) 

Web Menu Commands Access Keys 

Back ALT+B, B 

Forward ALT+B, F 

Stop ALT+B, T 

Refresh ALT+B, R 

Home  ALT+B, H 

Close Web ALT+B, C 

Search the Web ALT+B, W 

Go To Web Page... ALT+B, G 

History... ALT+B, Y 

Favorites... ALT+B, A 
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Window Menu (ALT+W) 

Window Commands Access Keys 

Next Document ALT+W, N 

Help Menu (ALT+H) 

Help Menu Commands Access Keys 

Search for help on... ALT+H, S 

WYNN Help... ALT+H, H 

About WYNN... ALT+H, A 
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Activation Options 

Software activation is an easy, one-time process that uses a 20-
character Authorization code to help Freedom Scientific verify your 
productôs license. The Authorization code is available on the 
Authorization CD and WYNNôs CD package. Use the Authorization 
CD to copy the code to your computer. This saves the time and 
trouble of having to manually type the 20-character code during 
the Activation process.  

If you do not have immediate Internet access, use the procedures 
in this chapter to activate your product. 

Before You Begin:  

1. Locate your 20-character Authorization number, which 
appears on the WYNN product packaging. 

2. Install your 20-character Authorization number as 
previously described in Activating WYNN on page 13.  

3. There are several ways to activate WYNN. Determine 
which method you want to use. For example: 

¶ Use the Internet to connect directly to Freedom 
Scientific and use the automated activation process. 
This is the fastest method and is recommended, as 
described in WYNN Installation Process on page 11.  

¶ Call Freedom Scientificôs Customer Support and 
request that an Activation License code be sent to you 
by e-mail or on a CD.  

¶ Send a fax to Freedom Scientificôs Customer Support 
and request that an Activation License code be sent to 
you by e-mail or on a CD. 
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¶ Use another computer with Internet connectivity to 
download an Activation License code from 
FSActivate.com. Once it is received, it can be copied 
to a disk or CD and used to activate WYNN.  

Starting the Activation Process  

Until you activate WYNN, the Activation dialog box appears each 
time you try to open the WYNN application.  

To start the activation process:  

1. Select the WYNN application shortcut from the desktop. 

2. From the WYNN Activation dialog box, click Activate.  

 

3. A WYNN dialog box appears. It contains the various 
activation methods.  



 Activation Options 

 

  217  

 

If you do not have immediate Internet access to activate the 
WYNN application, choose one of the following activation 
methods:  

¶ Activating by telephone, see below 

¶ Activating by fax, see page 221 

¶ Activating using FSActivate.com, see page 225 

Activating by Telephone 

There are two ways to request activation by calling Freedom 
Scientific directly.  

¶ Call and request that an Activation code be emailed to you. 

¶ Call and request that an Activation code be mailed to you. 

Note:  Activation by mail takes several days to complete since a 
CD must be mailed to you. 
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Requesting an Activation Code by Telephone  

To activate your product after receiving the Activation code in an 
email:  

1. From the WYNN Activation dialog, select Telephone to 

receive activation by mail, and click Next.  

 

2. Record your Locking code and the Customer Service 

phone number. Click Quit and exit WYNN activation.  










































